Getting Started with the Infor CRM Web Client
Important Notices

The material contained in this publication (including any supplementary information) constitutes and contains confidential and proprietary information of Infor. By gaining access to the attached, you acknowledge and agree that the material (including any modification, translation or adaptation of the material) and all copyright, trade secrets and all other right, title and interest therein, are the sole property of Infor and that you shall not gain right, title or interest in the material (including any modification, translation or adaptation of the material) by virtue of your review thereof other than the non-exclusive right to use the material solely in connection with and the furtherance of your license and use of software made available to your company from Infor pursuant to a separate agreement, the terms of which separate agreement shall govern your use of this material and all supplemental related materials ("Purpose").

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to maintain such material in strict confidence and that your use of such material is limited to the Purpose described above. Although Infor has taken due care to ensure that the material included in this publication is accurate and complete, Infor cannot warrant that the information contained in this publication is complete, does not contain typographical or other errors, or will meet your specific requirements. As such, Infor does not assume and hereby disclaims all liability, consequential or otherwise, for any loss or damage to any person or entity which is caused by or relates to errors or omissions in this publication (including any supplementary information), whether such errors or omissions result from negligence, accident or any other cause.

Without limitation, U.S. export control laws and other applicable export and import laws govern your use of this material and you will neither export or re-export, directly or indirectly, this material nor any related materials or supplemental information in violation of such laws, or use such materials for any purpose prohibited by such laws.

Publication Information

Release: 8.3.0.06
Publication date: February 21, 2017
## Contents

### Introduction

- Why Use Infor CRM? ......................................................... 1
- Key Features ............................................................... 1
- About This Guide .......................................................... 2
- Related Documentation .................................................. 2
- Contacting Infor ............................................................ 3

### Chapter 1 Understanding the Infor CRM Web Client Workspace

- Signing in to the Infor CRM Web Client ......................... 5
- Working in the Infor CRM Web Client ............................... 6
- Understanding the Workspace Features ............................ 7
  - Using List Views ....................................................... 8
  - Using Detail Views .................................................... 9
- Understanding the available buttons ............................. 10
- Getting Help ..................................................................... 11
- Understanding Infor CRM Office Integration .................... 12
  - Installing Office Integration ........................................ 12
- Understanding Infor CRM Integration with Microsoft Outlook ................................................ 13
  - Installing Infor CRM Xbar for Microsoft Outlook .......... 14
  - Configuring Outlook Integration ................................. 14

### Chapter 2 Managing Contacts and Accounts

- Adding a Contact and an Account ................................... 17
- Understanding Account Ownership ................................ 17
- Adding an Account Association ..................................... 19
- Working with the Library ................................................ 20
- Requesting Literature for a Contact ............................... 20
- Scheduling a Follow-up Activity ..................................... 21
- Adding a Note .................................................................... 22

### Chapter 3 Managing Your Sales Activities

- Using Activities and Events .......................................... 25
- Using Alerts .................................................................... 25
  - Alerts - Alarms Tab .................................................... 26
  - Alerts - Unconfirmed Tab .......................................... 27
- Completing an Unscheduled Activity ............................ 27
- Inviting Others to a Meeting ......................................... 28
- Using the Calendar ......................................................... 28
- Using the Activities View ............................................... 29
- Viewing a History of Interactions with an Account .......... 30
Introduction

Infor CRM is a leading customer relationship management solution that enables small to medium-sized businesses to acquire, retain, and develop profitable customer relationships through integrated Sales, Marketing, Customer Service, and Support automation solutions.

Saleslogix is now Infor CRM. Look for the new branding in this release and future releases.

All references to the CRM Core product, CRM Clients, Web Client, Windows Client, Administrator, and database refer to Saleslogix versions between 8.0 and 8.1 update 03 unless otherwise specified.

Why Use Infor CRM?

The Infor CRM Web Client helps you manage all aspects of the sales cycle and the customer relationship over the Web. In addition to tracking contacts, accounts, opportunities, tickets, and activities, users have access to tools for reporting, automating processes, and creating e-mails, faxes, and letters using mail merge.

Key Features

The following key features describe how you can use the Infor CRM Web Client:

- **Contact, Account, and Opportunity Views** - Use the Contact, Account, and Opportunity views to manage detailed information about your contacts, accounts, and opportunities.
- **Calendar and Activities** - Use the Calendar to view open and completed activities and events. Use the Activities view to manage such daily activities as scheduling phone calls, meetings, and events.
- **Lookups** - Use lookups to search for records or build groups. Lookups enable you to filter your record list, and then save the results as a new group. Lookup options vary by record type.
- **Groups** - Use groups to organize your contacts, accounts, opportunities, tickets, and other data based on common characteristics. Groups can be used for reporting, mail merges, and more.
- **Campaigns and Leads** - Use Leads to develop and qualify new Contacts and Accounts. Use the Campaign functions to combine advertising, public relations, sales promotion, and selling activities to achieve sales or marketing goals.
- **Mail Merge** - Use Mail Merge when you need to communicate with a group of contacts, accounts, opportunities, or leads.
- **Reports and Analysis** - Use Reports and filters to summarize information about your contacts, accounts, opportunities, contracts, and tickets. The Infor CRM Dashboard view allows you to display performance and analysis information in a dashboard format.
Customer Service and Support - Use tickets to track, qualify, and resolve customer questions and issues. You can track time spent working on a ticket through Punch in/Punch out, create ticket activities that are charged against the customer’s service contract, and schedule calendar activities. The Service and Support features also provide a means of tracking defects in products or services, and include a return process.

Literature Requests - Use literature requests to schedule sending marketing material or other documents to contacts. Literature requests are generally paper materials that must be mailed.

Library - Use the Library as a central repository for your company information. The Library often contains items such as product information, sales literature, and presentations.

Processes - Use processes to execute a series of tasks in a specific sequence over a set time period. The Infor CRM Web Client offers Sales Processes and Contact Processes.

About This Guide

The purpose of this guide is to help you begin using the Infor CRM Web Client. This guide uses scenarios to demonstrate how to use the Infor CRM Web Client for many of your daily tasks.

If your company has customized the Infor CRM Web Client, the number, order, and appearance of dialog boxes and screens may be different than described. See your system administrator for more information.

The Help symbol precedes online Help topic names where you can find additional information.

Related Documentation

- Infor CRM Quick Reference card provides commonly used buttons, e-mail configuration options, and tips for working with groups and Outlook Integration. The Infor CRM Quick Reference card is accessible from the Help menu.
- The Infor CRM Web Client Help provides detailed information about all of the features available over the Web, including additional information about Send to CRM and Mail Merge.
- The Infor CRM Mail Merge Help provides detailed information on the following: writing an e-mail message to a contact, writing an e-mail message, letter, or fax using a template, and using the Mail Merge engine to send correspondence to a group of contacts, accounts, etc. This help system also explains how to create and print address labels or envelopes, as well as, how to create, edit, and delete templates.
- New in Infor CRM v8.3: Compatibility information for Infor CRM v8.3 is available in the Infor Online Compatibility Matrix (OCM).
  1) Sign in to the InforXtreme Portal web site: www.infor.com/inforxtreme.
  2) Expand the Environment menu, and then click Online Compatibility Matrix.
  Click Help for a video explaining the features of the OCM.

Help is available in each Infor CRM application. Additional resources and documentation are available to Partners and Customers with a valid technical support contract at www.infor.com/inforxtreme.
Contacting Infor

If you have questions about Infor products, go to the Infor Xtreme Support portal at www.infor.com/inforxtreme.

If we update this document after the product release, we will post the new version on this website. We recommend that you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
Chapter 1
Understanding the Infor CRM Web Client Workspace

Take a few minutes to learn some of the Infor CRM Web Client basics. It will help you become familiar with the workspace and navigation features.

In this chapter, you will learn to:
- Log on to the Infor CRM Web Client
- Understand the Infor CRM Web Client workspace
- Install and use Office Integration
- Install and use Xbar
- Get more help

Signing in to the Infor CRM Web Client

Before you begin, locate your User ID and password. If you do not have this information, contact your system administrator.

To log on

1. Connect to your company's Web Client. If you have Windows Authentication configured, then you will not have to complete the remaining steps, but will be automatically logged on the Infor CRM Web Client. This can be done several ways, depending on your browser. In many browsers, it is faster to set the initial screen as the default screen of your browser, or to add the initial screen to a list of favorite sites.

2. Type your User ID and Password. Passwords are case-sensitive. In addition, your system administrator may set restrictions on using blank passwords, your user name as a password, and other options. If necessary, see your system administrator to discuss your password options.

3. If necessary, change the language setting. Changing the language will cause the Infor CRM Web Client to display in your selected language. If you do not select a language, then the Infor CRM Web Client will use the default language. The list of languages is based upon the languages supported by your organization.
   - Click the drop-down arrow and select a language from the list of supported languages.

   If your implementation uses Windows Authentication and you do not sign in to the Infor CRM Web Client, you can also select a language from the options User Profile tab.

4. Click Sign In.
To log off

- In the lower-right part of the browser window, click Sign Off.

**Working in the Infor CRM Web Client**

The workspace is the area where various views appear in the main Infor CRM Web Client.

Some features require you to enable pop-ups. See your browser help for specific instructions on how to allow pop-ups.

![Diagram of Infor CRM Web Client Workspace](image)

**Figure 1** Infor CRM Web Client Workspace
Understanding the Workspace Features

Each view in your Infor CRM Web Client contains many of the following elements.

Your workspace may be different depending on your access rights or if your installation has been customized.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>The title identifies the active view. When you are in a detail view, the title bar displays the name of the current record.</td>
</tr>
<tr>
<td>Navigation Bar</td>
<td>Located on the left side of the Infor CRM Web Client workspace, the Navigation Bar contains buttons that open the main Infor CRM Web Client views. The Navigation bar can be docked or hidden. If you cannot see the Navigation Bar, click the icon in upper left corner of your workspace. To dock the Navigation bar, so that it always appears, click the icon. To hide the Navigation Bar, click the icon. Your administrator can group the buttons into Navigation Group subsets that focus on specific elements of your business, such as Sales or Support. For example, the Support group contains Contacts, Tickets, Defects, Activities, Calendar, and Reports.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>The menu bar contains the Infor CRM Web Client commands. These include Recently Viewed, New, Schedule, Tools, Write, Past Due, Alerts, Job Notification, SpeedSearch, and the Help button. Click a menu to expand it.</td>
</tr>
<tr>
<td>Lookup</td>
<td>The Lookup button, located to the left of the group tabs in most list and detail views, allows you search from records using one or more search conditions.</td>
</tr>
<tr>
<td>Speed Search</td>
<td>SpeedSearch helps you find information stored in the Infor CRM database. For example, you can search through existing tickets or procedures to help solve a customer’s problem, or search for a specific document, like a sales presentation.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Tabs organize information on many of the list views, detail views and dialog boxes.</td>
</tr>
<tr>
<td>Pick Lists</td>
<td>A pick list is a set of values you can select from when entering data. Pick lists are useful because they encourage consistent data entry. Your access rights determine if you can add, edit, or delete pick list items. To open a pick list, click the drop-down arrow in the box.</td>
</tr>
<tr>
<td>Task Pane</td>
<td>The Task Pane displays to the right of the main window pane. The Task Pane consists of filters, common tasks and other features designed to help you complete your work. The available options depend on the record type and type of view where you are working.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>The status bar displays the user, date, time zone and Log Off button</td>
</tr>
</tbody>
</table>
Using List Views

List views display information in a list with columns and rows of information. Each tab in the list view contains a group of contacts, accounts, opportunities, or tickets and so on.

- You can customize your list view groups by adding or removing columns, changing the column order and adjusting column widths.
  
  See "Customizing List View Groups" in the Web Client online Help for more information.

- Clicking a column header sorts the information in that column. The arrow marker indicates whether the column is ascending or descending.

![Figure 2 Account List View](image_url)
Using Detail Views

Most records in Infor CRM display information in both a List view and a Detail view. The Detail view consists of information boxes, tabs, and a user-defined middle section.

- The upper section shows basic information about the selected record. When you add a new record, dialog boxes guide you through entering the information that appears in the Detail view. To edit information, click the box you want to change.

- The middle section is called the user-defined area. You can use this area to keep the tab you use most often visible. To move a tab to the middle section, click one of the tabs in the bottom section, hold the mouse button, and drag the tab to this area. The tab will remain open in the user-defined area each time you use the Infor CRM Web Client. If you want to change the tab in the middle section, select another tab and drag it to replace the current tab.

- The lower section contains a group of tabs. Each tab shows specific information you need for the related record. Your system administrator can create custom tabs for your company. Click the and select the check box of the columns you want to appear in the grid and clear the check boxes of the columns you want to hide in the grid. When finished, move your mouse cursor off of the menu and click to close the menu.

![Account Detail View](image)

**Figure 3** Account Detail View
Understanding the available buttons

Many features in the Infor CRM Web Client are accessed through buttons. The following list shows each of the buttons available, and describes the action each button performs. When you drag your mouse across a button in the Infor CRM Web Client, a tool tip explaining the button function appears. Buttons are referred to by their tool tip.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool tip or Description</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>📊</td>
<td>Account Service information</td>
<td>Click this button to open the Account Service Information dialog box.</td>
</tr>
<tr>
<td>+</td>
<td>Add, Associate</td>
<td>Click this button to add or associate an item.</td>
</tr>
<tr>
<td>+</td>
<td>Add Condition</td>
<td>Click this button to add another parameter to the Lookup on the List or Detail views.</td>
</tr>
<tr>
<td>+</td>
<td>Add URL</td>
<td>Click this button to attach a Web address URL.</td>
</tr>
<tr>
<td>⏰</td>
<td>Alerts</td>
<td>Click this button to view activities with triggered alarms and unconfirmed activities.</td>
</tr>
<tr>
<td>🔍</td>
<td>Associate</td>
<td>Click this button to associate an item.</td>
</tr>
<tr>
<td>📅</td>
<td>Calendar</td>
<td>Click this button to select a date and time.</td>
</tr>
<tr>
<td>↓</td>
<td>Collapse</td>
<td>Click this button to hide additional information in a list row.</td>
</tr>
<tr>
<td>✔️</td>
<td>Complete</td>
<td>Click this button to complete an activity.</td>
</tr>
<tr>
<td>🗿</td>
<td>Copy Information to the Clipboard</td>
<td>Click this button to copy contact information to the Clipboard.</td>
</tr>
<tr>
<td>✗</td>
<td>Delete or Remove</td>
<td>Click this button to delete or disassociate an item.</td>
</tr>
<tr>
<td>✍️</td>
<td>Edit</td>
<td>Click this button to edit information.</td>
</tr>
<tr>
<td>🖋️</td>
<td>Edit Form</td>
<td>Click this button to open the Web Form Designer. Only users with the appropriate role can access this feature.</td>
</tr>
<tr>
<td>⋮</td>
<td>Ellipses</td>
<td>Click this button to open a multi-select pick list.</td>
</tr>
<tr>
<td>⌨️</td>
<td>E-mail</td>
<td>Click this button to open a new e-mail message.</td>
</tr>
<tr>
<td>📜</td>
<td>Expand</td>
<td>Click this button to view additional information in a list row.</td>
</tr>
<tr>
<td>🔍</td>
<td>Find</td>
<td>Click this button to perform a lookup.</td>
</tr>
<tr>
<td>⟟</td>
<td>First</td>
<td>Click this button to view the first record in a group.</td>
</tr>
<tr>
<td>🤔</td>
<td>Help</td>
<td>Click this button to open Web Client Help.</td>
</tr>
<tr>
<td>📰</td>
<td>Job Notification</td>
<td>Click the drop-down arrow to display notification details and to access the result of your job. The number next to the icon shows how many jobs are available for you to view.</td>
</tr>
<tr>
<td>⏯</td>
<td>Last</td>
<td>Click this button to view the last record in a group.</td>
</tr>
<tr>
<td>Button</td>
<td>Tool tip or Description</td>
<td>Event</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------</td>
<td>-------</td>
</tr>
<tr>
<td><img src="image" alt="List View" /></td>
<td>List View</td>
<td>Click this button to switch to the list view.</td>
</tr>
<tr>
<td><img src="image" alt="Map" /></td>
<td>Map</td>
<td>Click this button to open a map using the current address information. If Contour integration is enabled and configured it will open a map using the Contour provider. If a provider is not configured then the address will open in MapQuest.</td>
</tr>
<tr>
<td><img src="image" alt="Mark this item as useful" /></td>
<td>Mark this item as useful</td>
<td>Click this button if you find a solution helpful, but are not pasting it into your ticket.</td>
</tr>
<tr>
<td><img src="image" alt="Maximize pane" /></td>
<td>Maximize pane</td>
<td>Click this button to maximize the size of the window pane.</td>
</tr>
<tr>
<td><img src="image" alt="Minimize pane" /></td>
<td>Minimize pane</td>
<td>Click this button to minimize the size of the window pane.</td>
</tr>
<tr>
<td><img src="image" alt="Move" /></td>
<td>Move</td>
<td>Click this button to move a contact to a different account.</td>
</tr>
<tr>
<td><img src="image" alt="Next" /></td>
<td>Next</td>
<td>Click this button to view the next record.</td>
</tr>
<tr>
<td><img src="image" alt="Past Due" /></td>
<td>Past Due</td>
<td>Click this button to open the Activities view Past Due tab.</td>
</tr>
<tr>
<td><img src="image" alt="Previous" /></td>
<td>Previous</td>
<td>Click this button to view the previous record.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh</td>
<td>Click this button to refresh the list of records in a list view.</td>
</tr>
<tr>
<td><img src="image" alt="Remove Condition" /></td>
<td>Remove Condition</td>
<td>Click this button to remove a parameter from the Lookup on the List or Detail views.</td>
</tr>
<tr>
<td><img src="image" alt="Reset" /></td>
<td>Reset</td>
<td>Click this button to clear any changes you’ve made since the last update.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
<td>Click this button to save your changes.</td>
</tr>
<tr>
<td><img src="image" alt="SpeedSearch" /></td>
<td>SpeedSearch</td>
<td>Click this button to open SpeedSearch.</td>
</tr>
<tr>
<td><img src="image" alt="User Date Stamp" /></td>
<td>User Date Stamp</td>
<td>Click this button to put a user name and date stamp in your ticket notes.</td>
</tr>
<tr>
<td><img src="image" alt="WWW" /></td>
<td>WWW</td>
<td>Click this button to go to a Web site.</td>
</tr>
</tbody>
</table>

### Getting Help

Information on advanced features and areas not covered in this guide is available in the Infor CRM Web Client online Help topics.

To access online Help

- Click the Help button 🎨.

<table>
<thead>
<tr>
<th>What do you want to do?</th>
<th>Topic Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log on to the Infor CRM Web Client.</td>
<td>Logging on to the Infor CRM Web Client</td>
</tr>
<tr>
<td>Find out what new features have been added to the Infor CRM Web Client.</td>
<td>What’s New in This Release</td>
</tr>
<tr>
<td>Find useful tips for first-time users.</td>
<td>New User Tips</td>
</tr>
</tbody>
</table>
What do you want to do? | Topic Name
---|---
Use Alerts to help me manage my activities. | Using Alerts
Customize the Infor CRM Web Client options for my personal needs. | Editing User Options
Schedule a meeting and invite others. | Scheduling or Editing an Activity
Schedule an Event (such as a trade show). | Scheduling or Editing an Event
Access an overview of Sales Processes. | What are Sales Processes?
Add a campaign response for a campaign target | Adding or Editing a Response Information

In addition to the Help, you can find more information from the following sources:

**System Administrator** See your system administrator for answers specific to your Infor CRM installation.

### Understanding Infor CRM Office Integration

The Infor CRM Office Integration Module provides support for:

- **Mail Merge**

  Mail Merge is only supported on Internet Explorer 9 and higher.
  - For more information, see "Supported Features By Browser" in the Infor CRM Web Client Help.

### Installing Office Integration

Before you can use Office Integration you must install Office Integration.

**To install Office Integration**

2. On the **Tools** menu, click **Options**.
3. Click the **General** tab.
4. Click **Install Office Integration**.
5. When prompted, click **Run**.
6. Click **Next**.
7. If prompted, close your browser.
8. Click **Install**.
9. Click **Finish**.
10. If you did not close your browser in step 6, sign off from the Infor CRM Web Client.
Understanding Infor CRM Integration with Microsoft Outlook

Outlook Integration features are now installed with Infor CRM Xbar for Microsoft Outlook.

The Infor CRM Xbar for Microsoft Outlook installation provides support for:

- **Xbar**
  - Access key contact information, activities and opportunities in Infor CRM from Outlook e-mail correspondence or calendar activities
  - Create new contacts, accounts and opportunities by dragging and dropping existing information from e-mail into the Xbar interface
  - Make changes to contact, calendar, and interaction history in Xbar that automatically updates within Infor CRM

For more information about Xbar for Outlook features, please refer to the Xbar help. Click the icon to open the Global menu and access the help file.

- **Outlook Integration**
  - Record email messages to history
  - Integrate with the Microsoft Outlook Address Book
  - Drag and Drop E-mail from Microsoft Outlook
  - Send an Infor CRM contact's information in a vCard file format via e-mail
  - Attach documents from Infor CRM Library to a message in Outlook

- **Infor CRM Activity Task Pane**

- **Using Outlook Synchronization allows you to synchronize:**
  - Contacts
  - Calendar
Installing Infor CRM Xbar for Microsoft Outlook

Before you can use any of these features you must install Infor CRM Xbar for Microsoft Outlook.

To install Infor CRM Xbar for Microsoft Outlook from the Infor CRM Web Client

1. Infor CRM recommends closing Outlook.
2. Sign in to the Infor CRM Web Client.
3. On the Tools menu, click Options.
4. Click the General tab.
5. Click Install Xbar for Outlook.
6. If prompted, click Save File, go to your downloads location, and click the Infor CRM XBar Setup.exe.
7. If prompted, click Run.
8. Click Install.
9. Click Close.
10. Open Outlook.
11. If prompted to use the Infor CRM Connector in Outlook, click Yes.
   The Infor CRM Connector Options dialog box opens.
12. If necessary, configure your Infor CRM Connector options.

Configuring Outlook Integration

Outlook integration preferences should be configured in Microsoft Outlook.

Before you can configure Outlook:

- Microsoft Outlook must be installed and running on the local machine.
  - Web - Infor CRM Xbar for Microsoft Outlook will not install unless Microsoft Office, including Outlook, is already installed.
  - Windows - If Microsoft Outlook was not installed before installing the Infor CRM Client, you must perform additional configuration steps.
- You must know the connection server and port number and your user name and password.
  Contact your system administrator for more information.

To configure

1. Open Microsoft Outlook.
2. If you are not prompted, click the Options button.
   If the Options button does not appear, then Outlook sync has not been installed properly.
3. Use the tabs to set the following options:
   - Connection - connection to the Infor CRM server. Required for contact and calendar synchronization and e-mail integration.
   - Xbar side Panel - set options specific to Infor CRM Xbar For Microsoft Outlook.
   - Send to CRM/Record to History - options for prompts, displaying information, and attachment behavior when using Send to CRM or Record to History. Used for e-mail integration.
   - Advanced - to enable drag and drop from Outlook to Infor CRM Web Client using all browsers, when your version of Infor CRM is 8.3.0.4 or later.
   - All Options - ability to view options as value pairs. Recommended for advanced users only.
     For more information see the Outlook Sync help topic "Configuring Outlook Sync".

4. Click **OK**.
Chapter 2
Managing Contacts and Accounts

This chapter introduces you to the core of Customer Relationship Management (CRM) - working with contacts and accounts.

- Contacts are the key people associated with an account.
- Accounts are your prospects and customers. Accounts can contain one or many contacts.

You can use Infor CRM to manage contact and account information. This includes daily interactions, such as phone calls, meetings, action items, or other correspondence.

In this chapter, you will learn to:

- Add a contact and an account
- Create an account association
- Use the Library
- Schedule a literature request
- Add a note and schedule a follow-up activity

Adding a Contact and an Account

Infor CRM focuses on account relationships. Therefore, all contacts must be attached to an account. Account and contact information is accessible by any Infor CRM user who has the appropriate security. For example, you can create an account for Beeker Motors. Your Sales Assistant may not have the required security to access the account, but your Sales Manager can.

Understanding Account Ownership

Before creating an account in Infor, it is important to understand account ownership.

- The Account Owner has access to an account and can use any account-related activities such as scheduling activities and running reports. An account owner can be an individual user, a team, or all Infor CRM users. Access to account data can be different for each user. For example, if a team owns an account, some team members may have read-only access to the account, while others have read/write access. Security is controlled by your system administrator.

- The Account Manager is responsible for managing the relationship with the account. This can include follow-up phone calls, meetings, preparing proposals, and working with the account’s contacts. The account manager is a single individual.

The individual user designated as the account owner is often also set as the account manager. If a team is the account owner, a team member will usually be set as the account manager. Account owners and account manager should be assigned according to your company’s guidelines.
There are several ways to add contacts and accounts to Infor CRM. This guide will explain the most common methods.

Our scenario:
You met Tom Dale and Joan Smith at a trade show. Tom and Joan (contacts) work for Beeker Motors (account). First you will add contact Tom Dale to a new account (Beeker Motors); then you will add Joan Smith to an existing account (Beeker Motors).

To add contacts and an account
1. On the **New** menu, click **Account/Contact**.
2. In the **Contact** box, type **Tom Dale**.
   To add hyphenated last names or names with a professional designation, click the **Edit** button next to the Contact box. Then use the Edit Name dialog box to specify a name prefix (such as Dr.), first name, middle name, last name, or suffix (such as C.P.A).
3. In the **Account** box, type **Beeker Motors**.
4. In the **E-mail** and **Web** boxes, add e-mail and Web address information.
   - E-mail - tom.dale@beeker.mail
   - Web: www.beeker.web
5. In the **Work Phone** field, type **5551234512**.
6. Click the **Look for Matching Records** button.
   This searches the database for records that have the same e-mail address, Web address, phone number, and account. It is important to search for records before adding information. If you do not check for existing information, you might create a duplicate contact or account.
7. Click **Cancel** to close the Matching Records dialog box, or if a duplicate record is found click **Open** next to a record to view additional details or **Use Account** to select a record.
   If you select Use Account, the account appears next to the Use Existing Account ... label in the Insert Contact/Account view.
8. In the **Contact Information** area, in the **Title** box, click the drop-down arrow and select **Vice President**.
9. Continue to add Tom’s information in the **Contact Information** section.
10. Under **Account Information**, double-click in the **Address** box to open the **Address** dialog box and add the Address information for Beeker Motors, as follows:
   - Leave **Description** as **Office**.
   - Select **Primary** to identify this address as the primary address for this account.
   - Click the **Address Type** drop-down arrow and select **Billing & Shipping**.
   - In the **Address 1** box type **1234 Gary Parkway**
   - In **City, State, Postal Code** type **Oak Park, IL 60305**
11. Click **OK**.
12. In the **Main** box type **5551234500**.
13. (Optional) Use the **MapQuest** icon to see a map of the address.
14. Click the **Type** drop-down arrow and select **Customer**.
15. Click the **Status** drop-down arrow and select **Active**.
16. Click the **Industry** drop-down arrow and select **Automotive/Aerospace**.
17. In the **Acct. Mgr.** box, click the **Find** button, and then select the account manager.
18. In the **Owner** box, click the **Find** button, and then select an owner.
19. In the **Lead Source** box, click the **Find** button, in the third box type *tr*, click **Search**, select **Trade Show** and then click **OK**.

20. Click the **Save & New** button.
   This option allows you to add another contact to the existing account.

21. In the **Contact** box, type **Joan Smith**.

22. In the **E-mail** and **Work Phone** boxes, add e-mail and Work Phone information.
   - E-mail - joan.smith@beeker.mail
   - Work Phone - 5551234519

23. In the **Contact Information** area, in the **Title** box, click the drop-down arrow and select **Managing Director**.

24. Click **Save**.

   ![For more information see the “Adding a New Contact and Account” topic in the Infor CRM Web Client Help.]

If you need to edit a contact or account’s information, you can do so by clicking the boxes on the Detail view and typing in the changes.

You must click the Save button after making any changes.

### Adding an Account Association

Accounts may have a common connection, for example, one company may be a parent of another. You can create a relationship between accounts by adding an association. This association can be helpful for tasks like running reports. You can create one report for both accounts rather than two separate reports. Associations can also create opportunities for you to sell to parent companies rather than subsidiaries.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tom Dale</strong> told you that Beeker Motors was owned by International Machines. You want to create a parent/subsidiary relationship between the two accounts.</td>
</tr>
</tbody>
</table>

To associate accounts

1. Open the Beeker Motors Account Detail view.
   a. On the Navigation Bar, click **Accounts**.
   b. Click the Lookup tab (magnifying glass).
   c. In the first box select **Account**, in the second box select **Starting With**, in the third box type **Be**, and then click **Search**.
   d. In the list, click Beeker Motors.

2. On the Beeker Motors Account Detail view, click the **Associations** tab. If the tab is not visible, click the **More Tabs** tab.

3. Click the **Add Association** button.

4. Click the **Find** button (magnifying glass).

5. In the **Lookup Account** box, make sure **Lookup Accounts by:** shows **Account**, type **Int**, and then click the **Search** button.

6. Click **International Machines** in the account list, and then click **OK**.

7. Click the drop-down arrow below **Beeker Motors is a** and select **Subsidiary**.
8. Click the drop-down arrow below International Machines is a and select Parent.

9. In the Description boxes, type a description for each account.

10. Click OK.

**Working with the Library**

The Library is a central repository for company information. Files are organized into folders and sorted by name. Click the column headings to sort the library files list.

Your company’s library may include product information, policies and procedures, presentations, Web addresses, and so forth. Only the administrator and an administrative user can add files to the Library.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to use the Library to find current product information.</td>
</tr>
</tbody>
</table>

**To access information from the Library**

1. On the Navigation Bar, click Library.

2. In the tree view, click the "+" signs to expand the folder that contains the file you want to open.

3. In the list, click the File name of the file you want to download.

4. Do one of the following:
   - Open the file
   - Save the file

For more information see the "Working with the Library" topic in the Infor CRM Web Client Help.

**Requesting Literature for a Contact**

Literature requests involve sending marketing materials or other company documents to one or more contacts. Infor CRM users or the system administrator manage the available literature. After you schedule a request, the person or group at your company responsible for literature fulfillment can fulfill and complete the request.

If you are making the request for a single contact, select the contact before you begin the following steps.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joan Smith requested information on a specific product at a trade show, but you had run out of brochures. You want to schedule a literature request to send the information to Joan.</td>
</tr>
</tbody>
</table>

**To schedule**

1. Open Joan Smith’s Contact Detail view.
   a. On the Navigation Bar, click Contacts.
   b. Click the Latest Contacts group tab.
   c. In the Task Pane, under Filters, click Name and select S.
   d. In the list, click Smith, Joan.

2. On the Schedule menu, click Literature Request.
3. In the **Description** box, enter a brief description of the literature request.
   - Type **Lenovo ThinkPad sales brochure**.

4. Click the **Send by Calendar** button, select a date, and then click **OK**.

5. In the **Send via** (delivery method), and **Priority** boxes, click the drop-down arrow, select **FedEx** and **Medium**.

6. Under **Print Literature List**, select with **cover letter**.

7. Click the **Cover Find** button, expand **Public Templates**, expand **Letter**, select **Company Information**, and the click **OK**.

   Selecting a template is only available in Internet Explorer, because the cover sheet requires Mail Merge which is only supported in Internet Explorer versions 9 and later. For more information see “Supported Features By Browser”.

   To use a template in Internet Explorer, you must download Infor CRM Office Integration. See "Understanding Infor CRM Office Integration" on page 12.

8. Under **Available Items**, select the items you want to include in your request.
   a. If necessary, click the **Filter available items** button and enter any characters contained in the family, number or name of the item you want to add.
   b. Select **Lenovo ThinkPad Brochure**.
   c. Double-click in the **Quantity** column and type the number of copies of that item you want to request. Type **2**.

9. Click the **Schedule Literature Request** button.

The literature request is recorded on the Literature tab in the Activities view and on the Literature Requests tabs in the Contact and Account Detail views.

The person assigned by the administrator to monitor Literature Requests will receive your request and should fulfill it by the date you specified.

### Scheduling a Follow-up Activity

In Infor CRM, phone calls, meetings, to-dos, and personal appointments are called activities. Scheduling follow-up activities can help you organize and remember important events.

#### Our scenario:

You want to schedule a phone call to follow-up on literature that was sent to Joan Smith.

#### To schedule a phone call

1. Open Joan Smith’s Contact Detail view.
2. On the **Schedule** menu, click **Phone Call**.
3. In the **Regarding** box, click the drop-down arrow, and select **Confirm Literature Received**.
4. Use the **Location** field to type a location.
5. In the **Start Time** box, click the **Calendar** button to select the date and time when the activity will occur, and then click **OK**.

6. Do one of the following:
Select the **Timeless** check box to create an activity that occurs on a specific date, but at no specific time and without a specific duration. Timeless activities are displayed on the Calendar day view.

1. In the **Duration** box, type or click the drop-down arrow and select from the list.

7. Select the **Alarm** check box to set an alarm to notify you before the activity begins. Type or select a length of time.

8. Verify the **Name** and **Account** boxes contain **Joan Smith** and **Beeker Motors**.
   If any information is incorrect, click the Find button to change the information.

9. After selecting a contact or lead, you can hover over the record name to see limited detailed information.

10. Verify that your name is in the **Leader** box.

11. In the **Notes** box, type **Follow-up call for Joan Smith's literature request.**

12. Click the **Availability** tab to make sure you are available at the selected Start Time and or to add resources or other members.

   ![Image](image.png)

   You can only add members or resources to phone calls and meetings.

13. Click the **Participants** tab to include additional contacts and leads.

   ![Image](image.png)

   If the Show history for all participants option is not selected, then you will see a history item for only the primary participant.

14. Click **OK**.

You can view the scheduled phone call in the Contact and Account Detail views (on the Activities tab), in the Activities view (on the All Open and My Activities tabs), and in the Calendar view.

![Image](image.png)

For more information see the "Scheduling or Editing an Activity" topic in the Infor CRM Web Client Help.

### Adding a Note

You use notes to document the outcome of an activity and to record interactions with an account, contact, lead, or opportunity. The notes you add appear in the Notes/History tab on the Account, Contact, Lead, and Opportunity Detail views.

There are several ways to add a note. One method was chosen for the example below.

#### Our scenario:

You found Tom Dale’s business card while cleaning out your briefcase. You had a note on the back indicating Tom was interested in a support contract for any products his company purchased. You want to add this information to Infor CRM.

#### To add a note

1. Open Tom Dale’s Contact Detail view.
2. On the **New** menu, click **Note**.
3. In the **Regarding** box, type **Business card notes**.
4. In the **Location** box, type **2017 Trade Show**.
5. If necessary, modify the **Completed** and **Scheduled** dates. To modify the date, click the **Calendar** button to select the date.

6. Leave **Timeless** selected since you do not need to enter a duration for the note.

7. Verify the **Name** is **Tom Dale** and the **Account** is **Beeker Motors**.

8. In the **Category** box, click the drop-down arrow and select an item from the list.

9. In the **Priority** box, click the drop-down arrow and select an item from the list.

10. Verify that your name is in the **Leader** box.

11. In the **Notes** box, type the information on the business card.

12. If necessary, click the **Attachments** tab to add a document or URL.

13. Click the **Follow-up** drop-down arrow and select the follow-up activity type. Select **To-Do**. Schedule a follow-up activity.

14. Use the **Carry Over Notes** or **Carry Over Attachments** check boxes to copy notes or attachments from this note to the follow-up activity.

15. Click **OK**.

16. In the **Schedule To-Do** dialog box, schedule an activity for today.
   a. For the **Regarding** type **Research**.
   b. In the **Notes** type, **Research a support contract for Beeker Motors**.
   c. Click **OK** to schedule the activity.

You can view notes on the Notes/History tab of the Contact, Account, Lead, and Opportunity Detail views. In addition, the Notes/History tab allows you to view and filter notes and other history items.

For more information see the "Adding a Note" topic in the Infor CRM Web Client Help.
Infor CRM can help you manage your daily activities, whether they are scheduled or unscheduled. Scheduled activities include phone calls, meetings, to-dos, and appointments. Unscheduled activities, such as returning a phone call or answering e-mail, may occur several times a day.

In this chapter, you will learn to:

- Use Alerts
- Complete an unscheduled activity and schedule a meeting
- Use the Calendar and Activities views
- View the history of an account

### Using Activities and Events

Activities and Events provide a way to stay on top of your work responsibilities.

- Events usually span several days and might include trade shows, business trips and conferences.
- Activities include placing phone calls, attending meetings, and to do’s, such as sending correspondence or preparing presentations.
- Activities can be associated with contacts, accounts, leads, opportunities, or tickets. Activities are generally scheduled for a specific time, but can also be scheduled as “timeless” activities. Completed activities become history items.
- You can schedule activities during an event, such as setting up various appointments and meetings for a business trip.

When you schedule an activity, it displays on the Calendar, Activities view, and in the Activities tabs on the Account, Contact, Opportunity, Lead, and Ticket views. Events display on the Activities view, Events tab and Calendar as well. The Infor CRM Web Client includes an Alerts feature that alerts you to overdue activities and new activities that you have yet to confirm.

Several activity types are available to accommodate your work requirements. For instance, you can create general activities, recurring activities and more. In general, you can edit, delete, or complete activities and events that you create.

### Using Alerts

Alerts help you keep track of activities with triggered alarms and unconfirmed activities. Your Alerts options determine how you will be alerted for alarms and new unconfirmed activities.

You can snooze or dismiss selected activity alarms, or snooze or dismiss all of your alarms. You can also view Activity details and accept or decline unconfirmed activities.
To view Alerts

- If the Alerts notification appears in your menu bar, click the drop-down arrow to display Alerts details.

If the Alerts notification does not appear in your menu bar, then either you have no current alerts or your Alerts options may need to be changed.

To minimize Alerts

- If you want to hide your active Alerts, click the drop-down arrow in the Alerts area of the menu bar. The Alerts view will remain minimized until you click the drop-down arrow again or you receive a new alert.

Alerts - Alarms Tab

The Alarms tab in the Alerts view lists activities with active alarms. You can snooze or dismiss alarms or view, complete or delete activities from the Alarms tab.

To snooze alarms

1. Select the check box for each activity alarm you want to snooze.
2. Select a time increment in the Snooze by box, and then do one of the following:
   - Click Snooze to snooze any selected activity alarms.
   - Click Snooze All to snooze all of the activity alarms, even if they are not selected.

To dismiss alarms

- Do one of the following:
  - Select the check box for each alarm you want to dismiss, and then click Dismiss.
  - To dismiss all alarms, click Dismiss All.

To go to the activity detail view

- Click the activity type and regarding information that appears in blue text next to the activity icon. Your Alerts are hidden and the activity detail view opens.

To go to view contact, account, or lead details

- To open the detail view, click the record name.

To complete activities

1. Select the check box for each activity you want to complete.
2. Click the Complete selected activities button in the top part of the view.

To delete activities

1. Select the check box for each activity you want to delete.
2. Click the Delete Selected button in the top part of the view.
3. Click OK to confirm the deletions.
Alerts - Unconfirmed Tab

An unconfirmed activity is an activity notification that you need to confirm or decline.

To view unconfirmed activity details
- Click the activity type and regarding information that appears in blue text next to the activity icon. Your Alerts are hidden and the activity detail view opens.

To accept or decline an unconfirmed activity
1. In the grid, click the unconfirmed activity that you want to accept or decline.
2. Do one of the following:
   - Click Accept to confirm that you will attend a phone call or meeting.
   - Click Decline to confirm that you will not attend a phone call or meeting.

To go to the Calendar view
- Click the Show Calendar link at the bottom of the view.

To go to the Confirmations tab on the Activity view
- Click the Show Confirmations link at the bottom of the view.

Completing an Unscheduled Activity

Unscheduled activities can occur unexpectedly throughout the day. It is a good idea to keep Infor CRM open at all times so you can quickly access contact and account information. After you respond to an unscheduled activity, you should complete the activity in Infor CRM to create a record of the interaction with the contact or account.

When you complete an activity, details about it are recorded on the Notes/History tab for the related account, contact, opportunity, or lead.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>You received an unexpected call from Tom Dale about a sales opportunity. You need to complete an activity for the unscheduled phone call and schedule a follow-up meeting.</td>
</tr>
</tbody>
</table>

There are several ways to complete an activity in Infor CRM. The following method allows you to complete the activity, schedule a follow-up meeting, and carry over the notes.

To complete an unscheduled activity
1. Open Tom Dale’s Contact Detail view.
2. On the Schedule menu, select Complete an Activity.
3. Select the Create a New Unscheduled Activity to Complete option.
4. Select Phone Call, and then click Continue.
5. In the Regarding box, click the drop-down arrow and select Discuss Opportunities from the list.
6. The Completed and Scheduled boxes automatically show the current date and time. You can accept the default, or select a new date and time.
7. In the Notes box, type Tom Dale called about a possible sales opportunity.
8. To schedule a follow-up activity
   a. Click the **Follow-up** drop-down arrow and select **Meeting**.
   b. Select **Carry Over Notes** to include your notes in the follow-up activity.
9. Click **Now** to complete the unscheduled activity.
10. In the **Schedule Meeting** dialog box, verify that the **Notes** field includes the notes from the phone call.
11. Select a date and time for the meeting, and then click **OK** to schedule the follow-up meeting

For more information see the "Completing an Activity" topic in the Infor CRM Web Client Help.

### Inviting Others to a Meeting

When you schedule or edit a meeting or a phone call in the Infor CRM Web Client, you can include other Infor CRM users in the activity. These types of appointments appear on the Confirmations tab in your Activities view. You can accept or decline activities listed on the Confirmations tab. You may also receive an alert when you have an unconfirmed activity.

**Our scenario:**

You want to invite a co-worker (from your company) to your meeting with Tom Dale (a contact for Beeker Motors).

**To invite others to a meeting**

1. Open Tom Dale’s Contact Detail view.
2. Click the **Activities** tab.
3. In the list, open the meeting you scheduled in the previous scenario.
4. Click the **Availability** tab.
5. Click the **Add Members and Resources** button.
6. In the **Available Members** list, select a user, then press the **CTRL** key and select **Conference Room 100**, and then click **Add**.
7. Use the Availability tab to make sure you, the other user, and the conference room are available for the meeting.
8. Click **OK**.

The other user will receive an Alert to confirm the activity. After the user confirms or declines the meeting, you will receive a confirmation of the response.

For more information see the "Scheduling or Editing an Activity " topic in the Infor CRM Web Client Help.

### Using the Calendar

Use the Calendar to manage your time and keep track of scheduled activities and events. The Infor CRM Calendar displays both open and completed activities and events, depending on your calendar options. You can view your schedule by the day, week, or month view. Use the calendar right-click menu to schedule, edit, complete, or delete activities and events.
Your calendar security determines whose activities you can schedule, view, edit, complete or delete. Depending on your access rights, you can view the calendars and activities of other Infor CRM users. Each user has an assigned color to help identify which activities are for each user.

Some icons may not appear in week and month views due to limited space.

### Our scenario:
You want to check your calendar to see if you have time available to meet with your co-worker before the meeting with Tom Dale.

### To view the calendar
1. On the Navigation Bar, click **Calendar**.
2. Select the type of calendar to view.
   - Day View - Displays a timeline for the day. Lists all scheduled activities and events for that day.
   - Work Week View - Displays only the days in your work week as defined in your user options. Lists scheduled activities and events for each day.
   - Week View - Displays each day in the selected week. Lists scheduled activities and events for each day.
   - Month View - Displays month calendar, listing scheduled activities for each day.
3. Each scheduled activity in the calendar is a link to the activity detail view. Rest your mouse over the activity to view its details. Click a link to open the selected activity.
4. To view another user's calendar, select the user's name from the **Calendar Users** list.

For more information see the "Using the Calendar" topic in the Infor CRM Web Client Help.

### Using the Activities View
Use the Activities view to manage your scheduled activities, events, literature requests, and confirmations. If you have additional access rights, you can also view other Infor CRM users' activities.

The tabs that appear in the Activities view are:

<table>
<thead>
<tr>
<th>My Activities</th>
<th>All Open</th>
<th>Past Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms</td>
<td>Events</td>
<td>Confirmations</td>
</tr>
<tr>
<td>Literature</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following icons provide information about the activity:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📞</td>
<td>Phone Call</td>
</tr>
<tr>
<td>📅</td>
<td>Meeting</td>
</tr>
<tr>
<td>📌</td>
<td>To-Do</td>
</tr>
<tr>
<td>✔</td>
<td>Personal Activity</td>
</tr>
</tbody>
</table>
### Icon Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>The activity is unconfirmed. (Not available on all tabs)</td>
</tr>
<tr>
<td>📞</td>
<td>The activity has an attachment</td>
</tr>
<tr>
<td>🔄</td>
<td>The activity is a single occurrence of a recurring activity</td>
</tr>
<tr>
<td>⏰</td>
<td>The activity has an alarm</td>
</tr>
</tbody>
</table>

### Our scenario:

You want to see how many phone calls you have tomorrow.

**To view phone calls scheduled for tomorrow**

1. On the Navigation Bar, click **Activities**.
2. Click the **My Activities** tab.
3. Use the Task Pane **Filters** to narrow the list:
   - Expand the **Activity Type** filter and select **Phone Call**.
   - Expand the **Time Frame** filter and select **Tomorrow**.
   All of the calls you have scheduled for tomorrow are shown in the tab.
4. (Optional) You can click the activity type to view its detailed information and make any required changes.

### Viewing a History of Interactions with an Account

When responding to scheduled or unscheduled activities, you may need to view the history of interactions with the contact and account or lead. For example, if a customer calls to ask a question she had from your last meeting, you can open the account history to view the meeting notes. The Notes/History tab contains all interactions, including full text notes, and provides filter options for viewing, e-mailing, and printing history items and notes.

If the Show history for all participants option is not selected, then you will see a history item for only the primary participant.

### Our scenario:

You want to review all the interactions you have had with anyone at Beeker Motors.

**To view account history**

1. Go to Beeker Motors’ Account Detail view.
2. Click the **Notes/History** tab. If the tab is not visible, click the **More Tabs** tab.
3. If necessary, click the **Filter** button and use the filters to narrow the list of history items.
4. Click the **Type** link of the history item you want to view.

For more information see the "Notes/History Tab" topic in the Infor CRM Web Client Help.
Chapter 4
Communicating with Contacts and Leads

In addition to telephone calls and meetings, you may need to send additional information to your contacts or leads, such as proposals, letters, or memos. Through the Infor CRM Write menu, you can create and edit templates, letters, and other business correspondence. You can then use Mail Merge to merge your template to contacts, leads, accounts, or opportunities.

If the Write menu is unavailable, you must download Infor CRM Office Integration. See "Understanding Infor CRM Office Integration" on page 12.

Outlook Integration with Infor CRM enables you to share information between Microsoft Outlook and Infor CRM when you write e-mail messages, add contacts, and schedule meetings.

Outlook Integration features are now installed with Xbar. See "Understanding Infor CRM Integration with Microsoft Outlook" on page 13.

In this chapter, you will learn to:
- Create a template
- Use Mail Merge to send information to contacts
- Work with Microsoft Outlook e-mail

Working with Templates

You can use templates to create letters, proposals, faxes, or e-mail messages that will be used for more than one contact or lead. Templates use standard text that does not change, as well as mail merge fields that use Infor CRM information that changes depending upon the contact or lead being merged. Infor CRM has two types of templates:

- **Public templates** are created and distributed by the system administrator and stored in the Public Templates folder. Public templates usually are released to all users. When you copy a public template and save it to your computer, it becomes a private template.

- **Private templates** are created by a user and are automatically stored in the Private templates folder. When you create a private template, only you have access to the template.

Templates are created using Microsoft Word, so you must have Microsoft Word installed on your local machine for template creation.

For more information see the "Managing and Selecting Templates" topic in the Infor CRM Web Client Help.
Creating a New Template

These instructions help you create a new private Microsoft Word template.

**Our scenario:**
Tom Dale requested a pricing proposal for 150 motors. You need to create a new pricing proposal template.

**To create a new template**
1. On the **Write** menu, select **Manage Templates**.
2. In the **Manage Templates** dialog box, click **New**.
3. In the **Properties for: New Word Template** dialog box, do the following:
   a. In the **Template Type** section, select **E-mail**.
   b. In the **Name** box, type **Pricing Proposal**.
   c. In the **Family** box, select **E-mail**.
   d. In the **Main Table** box, select **Contact**.
   e. In the **Owner** box, your name should appear as the owner.
   f. Click **OK**.
      Microsoft Word opens for you to create the new template.
4. In the empty document, type the text you want to include in the proposal template.
5. To add Infor CRM merge fields to the template, place the cursor in the template where you want the merge field to appear, click **Insert SLX Field**, then from the merge field list, select a field.
      The new merge field appears in the template.
6. Click **Save and Close**.
      The Pricing Proposal appears in the Private Templates folder under the E-mail family.
7. In the **Manage Templates** dialog box, click **Close**.

Using Mail Merge

You can use Mail Merge when you need to correspond with a group of contacts, accounts, opportunities, or leads. Mail Merge helps you simplify the process of sending the same information to numerous people by merging information into a template. You can merge to a file, send an e-mail, send a fax, or print the merged document.

**Our scenario:**
You recently provided a demonstration for upgrading all of your contacts at Beeker Motors, and want to send a letter thanking them for their time. You want to run a mail merge to send the information to all contacts at once.

**To send e-mail using Mail Merge**
1. On the **Write** menu, click **Mail Merge**.
   The Mail Merge dialog box appears.
2. In the **Template** box, click the **Open** button, expand the **Public Templates** list, expand the **E-mail** list, and then double-click the **Thank you - Demo** template.
3. In the **Merge With** area, select **Specific**, select **Account**, and the click the **Find** button.
4. In the Lookup, type **Be**, click the **Find** button, and then double-click **Beeker Motors** in the list.
5. In the **Output To** area, select **E-mail**.
6. In the **From** box, your name appears.
7. (Optional) Click the Address Book in the **CC** and **BCC** boxes to select any other recipients.
8. In the **Format** box, the default format of your selected template is shown; select another format if desired.
9. Click the **History Options** tab.
10. Make sure the **Add History record for each Contact** option is selected.
11. In the **Category** box, click the ellipsis button, select **Demo**, and then click **OK**.
12. Click **Merge**.
   The merged e-mails are sent to all recipients and history records are added for both contacts.

For more information see the "Using Mail Merge" topic in the Infor CRM Web Client Help.

### Using Outlook Integration

Outlook Integration features are now installed with **Infor CRM Xbar for Microsoft Outlook**.

If your company uses Outlook Integration, you can save Outlook e-mail messages as Infor CRM history items. For example, you can:

- Compose an e-mail message in Outlook, select contacts from the Infor CRM Address Book, and then click Send to CRM to record the e-mail body and any attachments to the associated record. You can also include attachments to the message.
- Select an e-mail message in Outlook, and then click Record to History to record the e-mail body and any attachments to the associated record.
- Send an Infor CRM contact's information in a vCard file format via e-mail.
- Attach documents from Infor CRM Library to a message in Outlook.
- Drag and drop e-mail messages from Outlook to the Infor CRM History tab.
- Click the E-mail button on the Contact or Lead Detail view to open a new e-mail message addressed to that lead or contact.
- Click the E-mail button on the Ticket Detail view to copy ticket information into a new e-mail message, and then click Send to CRM in Microsoft Outlook to send the message and save it to Infor CRM.

For more information see the following topics in the Infor CRM Web Client Help:

- "E-mailing a contact or Lead"
- "Installing and Using Infor CRM Desktop Integration"
- "Sending an E-mail Message from a Ticket"
Our scenario:

You want to send an e-mail to Tom Dale and Joan Smith of Beeker Motors to tell them that you will be out of the office for a few days. You can use Microsoft Outlook and record the e-mail message in Infor CRM.

To send an e-mail to multiple records using Outlook Integration

1. On the Navigation Bar, click Contacts.
2. Use the Lookup to find the contacts you want to e-mail.
   a. Click the Lookup tab (magnifying glass).
   b. In the first box select Account, in the second box select Starting With, in the third box type Be, and then click Search.
3. Select Tom Dale and Joan Smith.
   To select more than one record, hold down [Ctrl] or [Shift], and highlight the records.
4. From the Task Pane, under Common Tasks, select E-mail.
5. If the Select Names dialog box opens, select both names and click the To button, and then click OK.
6. If e-mail is enabled, but you have not logged on, at the message box, click Yes to log on.
7. In the Subject line, type Out of Office.
8. In the Body area, type I will be out of the office for a few days. I'll contact you when I return.
   Since you are using Outlook to send this e-mail message, you may want to record this to Infor CRM History.
9. Click the Send to CRM button.
Chapter 5
Managing Opportunities for Sales

Opportunities are potential sales to accounts and contacts. As an opportunity progresses, you can track the products involved in the opportunity, days in the pipeline, competitors, level of commitment by the prospect, and much more.

In this chapter, you will learn to:
- Add an opportunity
- Use Opportunity Statistics
- Close an opportunity

Adding a New Opportunity

Use the Insert Opportunity view to enter opportunity information and to add, edit, or remove products, competitors, or contacts. You can also update the opportunity currency and rate if you have Multi-Currency enabled.

If you frequently use the same settings when adding opportunities, you can set default values. For more information see the "Setting Opportunity Options" topic in the Infor CRM Web Client Help.

It is not necessary to complete all information when you add an opportunity. You can add the information that is most important to your company when you add the opportunity, and then update the Opportunity Detail view with more information later. For example, when you add an opportunity, you may want to note the probability of closing the sale, the dollar amount, and the estimated close date. Then add information as the opportunity moves through the pipeline.

- If you do not want to add products while adding a new opportunity, you can add them later using the Products tab in the Opportunity Detail view.
- Adding contacts to an opportunity allows you to target the individuals at the account and designate their roles and influence in the possible sale. If you do not add contacts while adding the new opportunity, you can add them later using the Contacts tab in the Opportunity Detail view.

Our scenario:

There is an opportunity for a sale of 10 printers to Beeker Motors. You want to create a new opportunity and add products and contacts.

To add a new opportunity

1. Open the Beeker Motors’ Account Detail view.
3. Complete the following information:
   - Based on your Opportunities options, some boxes may already be completed.
- **Description** - Enter a name for the opportunity. To help track opportunities, use the account name in the opportunity description.
- **Account** - Verify that Beeker Motors appears.
- **Acct. Mgr.** - Click the Find button to find the person or team within your organization who manages the account.
- **Est. Close** - Click the Calendar button, select the date that the opportunity is estimated to close, and then click OK.
- **Status** - Your company defines the opportunity status list. Click the drop-down arrow, and select a status from the list.
- **Type** - Click the drop-down arrow, and select New.
- **Lead Source** - Click the Find button, click Search, and select Trade Show. Click OK.
- **Close Prob.** - Click the drop-down arrow, and then select the probability that this opportunity will be closed from the list.

4. Add the opportunity products.
   a. In the Products section, click the Include Product button.
   b. From the lookup, select NetPrinter Laser Elite, click Add Selected, and then click Close.
   c. In the grid, click the Quantity column and change 1 to 10.

5. Add the opportunity contacts.
   a. In the Contacts section, click the Include Contact button.
   b. From the lookup, select Joan Smith and Tom Dale, click Add Selected, and then click Close. From the lookup, select Joan Smith and Tom Dale, click Add Selected, and then click Close.

6. Click Save.

### Using Opportunity Statistics

You can use Opportunity Statistics to view opportunity information at a glance. You can view opportunity statistics for a group of opportunities, or you can select individual opportunities from the Opportunity List view.

**To open Opportunity Statistics**

1. On the Navigation Bar, click the Opportunities button.
2. In the Opportunities List view, open the group of opportunities you want to view. You can open the opportunity group using the Opportunity Group list.
3. Select the records you want to view, and do one of the following:
   - Right-click and select Opportunity Statistics.
   - In the Task Pane, under Common Tasks, click Opportunity Statistics.
4. When finished, click Close.
Closing an Opportunity

When an opportunity is won or lost, you should close the opportunity. For future reference and reporting purposes, you should provide the reason for closing the opportunity.

**Our scenario:**
Beeker Motors has agreed to your terms and pricing and now you may close the opportunity.

To close an opportunity
1. Open the Beeker Motor's opportunity in the Opportunity Detail view.
2. In the **Status** box, click the drop-down arrow, and select **Closed-Won** from the list. The Close Opportunity dialog box opens.
3. In the **Actual Amount** box, verify the amount of the sale is listed.
4. If necessary, modify the **Actual Close** date. To modify the date, click the **Calendar** button, select a new date, and then click **OK**.
5. In the **Reason Won** box, click the **ellipsis** button, select an item or items from the list, and then click **OK**.
6. In the **Comments** box, type *Delivery must be complete by the end of the financial quarter.*
7. Click **OK**.
   Beeker Motors’ Opportunity Detail view appears with a Closed-Won Status and the Probability automatically updates to 100%.

To add an asset to an account
1. Click the **Beeker Motors** link.
2. Click the **Assets** tab. If the tab is not visible, click the **More Tabs** tab.
3. Click the **Add Asset** button.
4. In the **Add Asset** dialog box, click the **Name Find** button.
5. From the lookup, search for and select **NetPrinter Laser Elite**, and then click **OK**.
6. In the **Quantity** box, type 10.
7. In the **Serial Number** box, type BMNPLE001.
8. Click **OK**.
   The asset appears in the product list for that account.
Chapter 6
Managing Leads and Campaigns

This chapter is an introduction to Infor CRM Marketing. With Infor CRM Marketing you can develop and qualify new sales leads, convert leads into customer in a structured process, and create and manage sales campaigns while tracking their effectiveness.

In this chapter, you will learn to:
- Add leads to Infor CRM
- Import leads to Infor CRM
- Qualify a lead
- Add a campaign
- Add targets to a campaign
- Add stages and tasks to a campaign
- Add products to a campaign
- Launch a campaign
- Track campaign responses

Working with Leads

Leads are unqualified potential customers. Use lead qualification criteria to determine if a lead has valid information, already exists as a lead or contact, or is ready to be converted to a sales opportunity. Once qualified, a lead can be converted to or merged with a contact and account. You can also create a new sales opportunity.

Adding a Lead

There are many ways in which your company can acquire leads. They may buy lead lists, acquire another company’s customers, or find a single lead while maintaining current accounts. If you have multiple leads, importing the information to Infor CRM is the most efficient method. However, if you cannot import lead information, you must manually add the lead(s) to Infor CRM.

Our scenario:
While you were speaking to a current contact, he mentioned his friend Bob Green may be interested in purchasing some software. You need to add Bob Green to Infor CRM as an unqualified lead.

To add
1. On the New menu, click Lead.
2. In the Name box, type Bob Green.
3. In the **Company** box, type **Green Dentistry**.

4. In the **E-mail** box, type **bob.green@greendentist.mail**.

5. In the **Phone** box, type **5553211234**.

6. Click **Look for Matching Records** to search the database for leads, contacts and accounts that have matching information.

   The Matching Leads dialog box appears. If a matching record displays in this dialog box, you can open the matching record to see if the lead, contact, or account is the same as the lead you are entering.

7. In the **Matching Leads** dialog box, click **Cancel**.

8. In the **Title** box, select or type **Managing Director**.

9. In the **Industry** box, click the drop-down arrow, select **Healthcare/Medical/Pharmaceutical**, and then click **OK**.

10. In the **Interested In** box, type **accounting software**.

11. In the **Lead Source** box, click the **Find** button.

12. In the **Lookup Lead Source** dialog box, click the **Find** button, select **Word of Mouth/Referral**, and then click **OK**.

13. Click **Save**.

**Importing Leads**

Your company may purchase mailing lists or have a large number of potential customers that must be tracked in Infor CRM. Rather than adding leads one at a time, you can import large numbers of leads to Infor CRM quickly and easily.

Use the Import Leads view to import lists of leads into Infor CRM. You may only import leads from a comma-separated-values (CSV) list. Valid file types include Microsoft Excel, .txt files, and other database file types, but files must be saved as a CSV file.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your manager has given you a file containing 200 leads. You want to import the leads into Infor CRM so that you can begin calling them.</td>
</tr>
</tbody>
</table>

To import leads

1. From the **Tools** menu, click **Import Leads**.

2. Next to the **Select a file containing Leads information to start** box, click **Browse**, browse to the list you want to import, and then click **Open**.

3. Click the **Default Owner Find** button to select the person or team within your organization that will own the imported leads.

4. Click the **Default Lead Source Find** button and select **Purchased List - General**.

5. Make sure **Create a new ad hoc group** is selected.

6. Click **Next**.

   The wizard moves to Step 2, Define Delimiter.

7. Preview the records before they are imported. If necessary, select a different delimiter value, for example a comma, semicolon, or text qualifier.

   For more information see the “Defining a Delimiter” topic in the Infor CRM Web Client Help.

8. Click **Next**.
9. Match the lead list fields and Infor CRM lead fields. If you want to display all of the fields in both lists and any template, select **Show All Fields**.
   a. Select the external list field and Infor CRM field to be matched.
   b. Click **Match**.
      Matched Infor CRM fields display in the Matched Infor CRM Field column.
10. Repeat the previous step for each field that needs to be matched.
11. Click **Next**.
    The wizard moves to Step 4, Manage Duplicates.
12. Complete the Manage Duplicates information.
   a. Select **Check for duplicate leads**.
   b. Next to **Type**, select **Contact** and **Lead** make sure records do not already exist as a contact or lead.
   c. Under **Match Filters**, select the filter check boxes that you want to apply. For example, First Name, Last Name, Work Phone, E-mail, Account/Company.
   d. For this scenario, clear the Auto-merge duplicate records option.
      For more information see the “Rules for Automatically Merging Records During Import” topic in the Infor CRM Web Client Help.
   e. If you want to check for duplicate records within the import source file, select the **Check for duplicates contained within the import source file** option.
   f. Click **Run the Test** to run the Find Duplicates Test on the first 100 records in the import or all of the records if you selected the previous option.
      For more information see the “Managing Duplicate Records” topic in the Infor CRM Web Client Help.
13. Click **Next**.
    The wizard moves to Step 5, Select Import Actions.
14. Complete the Select Import Actions information.
    Use import actions to specify actions to be performed for the leads you import to Infor CRM.
    a. Next to the **Add Note** action, click **Define**.
    b. In the **Add Note** dialog, select **Timeless**, and in the **Notes** box type **This record was imported from a list**.
    c. Click **Save**.
      For more information see the “Selecting Import Group Actions” topic in the Infor CRM Web Client Help.
15. Click **Next**.
    The wizard moves to Step 6, Review.
16. Review the import selections and click **Submit**.
    The wizard moves to Step 7, Process Request.
17. When the import is finished, click the **Import Number** link to see the import history results in the Import History view.
Qualifying a Lead

A lead may contain unqualified information. You can use lead qualification criteria to validate information and determine if the lead is a sales opportunity. Once qualified, you can convert a lead to a contact and account and create a new sales opportunity.

Our scenario:
You spoke to Bob Green on the phone and he has decided to order from your company. You need to add the information regarding Bob’s purchase and convert him to a qualified lead.

If your Qualification criteria was customized by your administrator, the items you see in your workspace may be different.

To qualify a lead
1. Click the Leads button on the Navigation bar.
2. Click the Lookup tab (magnifying glass).
3. Use the Lead lookup dialog box to find Bob Green:
   a. In the Lookup by box, select Name.
   b. In the next box, select Starting with.
   c. In the third box, type green, and then click Search.
4. In the list, click Green, Bob.
5. In the Qualification box, click the drop-down arrow, and then click Lead.
6. Under Qualification:
   a. Select the Valid Contact check box.
   b. Select the Budget for purchase check box, and then in the corresponding text box type 5000.
   c. Select the Timeframe for purchase check box, and then in the corresponding text box type 3 months.
   d. Select the Business need identified check box, and then in the corresponding text box type accounting software.
   e. Select the Decision maker identified check box, and then in the corresponding text box type Bob Green.
7. Once the lead is qualified and ready to convert to a contact and account, click the Convert Qualified Lead button.
8. In the Convert Lead dialog box, verify that no existing contacts or accounts match the lead you are qualifying.
9. Click Convert.
Working with Campaigns

A campaign is a combination of various advertising, public relations, sales promotion, and selling activities used over a period of time to achieve predetermined sales or marketing goals. A campaign can target a specific industry or group. Infor CRM Marketing allows you to track information such as the time frame of the campaign, products associated with the campaign, response rates for a campaign, and more.

Adding a Campaign

After you have determined what type of campaign your company plans to use, you can add the information to Infor CRM.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your company has decided to run a return mail advertisement campaign to all leads and contacts in the state of Illinois. You need to add the campaign information to Infor CRM. This includes the campaign targets, stages, and tasks that must be completed during the campaign.</td>
</tr>
</tbody>
</table>

To add a campaign

1. On the New menu, click Campaign. The Insert Campaign dialog box appears.
2. In the Campaign Name box, type IL Return Mail Ad Q4 FY2017.
3. In the Description box, type Return mail advertisement for IL - Fall 2017.
4. In the Objective box, type Promote PC v7. In this scenario, the objective of the campaign is to promote the new version of Pocket PC.
5. In the Call to Action box, type Pre-register and save 10%.
6. In the Lead Source box, click the Find button, and next to Advertising - General, click Associate.
7. In the Status box, select Setup.
8. In the Code box, type RMAAdQ42017. The code is a unique identifier for this campaign.
9. In the Start Date box, type or select next Monday's date.
10. In the End Date box, select a date 3 months in the future.
11. In the Manager box, click the Find button, select your name, and then click OK.
12. Click Save.

Adding Targets to a Campaign

When you identify your targets, you isolate the contacts, accounts, and/or leads on which to focus your marketing efforts. Effectively targeting your audience allows you to make the most of your marketing campaign by spending time and money on a segment of the market most likely to purchase from your company.

To add targets to a campaign

1. On the Navigation Bar, click Campaigns.
2. Open the IL Return Mail Ad Q1 FY2017 campaign in the Campaign Detail view.
3. Click the Targets tab.
4. Click the Add Targets button.
5. Use the filters to narrow the list of records.
   a. Select Accounts (all Contacts).
   b. Select the State check box, select Starting with in the drop-down box, and then type IL in the text box.
6. To find out how many targets meet the filter criteria before searching, click the How Many? button.
7. Click Search.
8. Click the Add Targets button to add all the targets in the list and close the dialog box.
   The targets appear in the Targets tab grid.

Adding Campaign Stages and Tasks

To add a stage to a campaign
1. Open the IL Return Mail Ad Q4 FY2017 campaign in the Campaign Detail view.
2. From the Campaign Detail view, select the Stages/Tasks tab, and then click Add Stage.
3. In the Description box, type Prepare ad slick.
4. In the Status box, click the drop-down arrow, and select In Progress.
5. In the Comments box, type Used in-house ad department. Updated campaign previously targeted to state of CA.
6. In the Start Date box, select today’s date.
7. In the End Date box, select a date one week from today.
8. Click OK.

Campaign tasks can help Infor CRM Marketing users manage their campaigns. You can add and edit task information, or complete a task once it is finished.

To add tasks to a campaign
1. In the Campaign Detail view, on the Stages/Tasks tab, click Add Task next to the appropriate campaign stage.
2. In the Description box, type Update CA ad slick from FY2011 Q4 campaign.
3. In the Status box, click the drop-down arrow and select Completed.
4. In the % Complete box, type 100.
5. In the Needed Date box, select yesterday's date.
6. In the Assign to section, select Other Individual.
7. In the Assign To box, type Advertising Dept - Tom.
8. Click OK.
9. To add another task, click Add Task next to the campaign.
10. In the Description box, type Print new ad slick.
11. In the Status box, click the drop-down arrow, and then select In Progress.
12. In the Needed Date, select a date 6 days from today.
13. In the Assign to section, select Other Individual.
14. In the Assign To box, type Print Vendor.
15. Click OK.
Adding Products to a Campaign

Products are the goods and/or services that you are selling in a campaign. You can add products to a campaign when you add the campaign information to Infor CRM, or you can add or change product information for an existing campaign.

Our scenario:

Management wants to add an additional incentive for the campaign. You need to add additional products to the direct mail campaign.

To add products to an existing campaign

1. Open the IL Return Mail Ad Q4 FY2017 campaign in the Campaign Detail view.
2. Click the Products tab. If the tab is not visible, click the More Tabs tab.
3. Click the Associate Products button.
4. Select GoStore 200GB and Kiva Big Mouth Briefcase, and then click Add Selected.

Launching a Campaign

When all campaign information has been added to Infor CRM, you are ready to launch the campaign. Launching the campaign allows Infor CRM to begin tracking information used in reports, budgets, and so on.

When a campaign is launched, the campaign target contacts and leads are assigned to the first stage of a campaign and their status is changed to "Launched".

Our scenario:

After verifying all the campaign steps and information, you want to launch the campaign.

To launch a campaign

1. Open the IL Return Mail Ad Q4 FY2017 campaign in the Campaign Detail view.
2. Verify all the information is correct.
3. Click Launch.
Tracking Campaign Responses

After you launch a campaign, you can begin to track the responses associated with the campaign. Campaign responses include who responded, the date, the response method, any notes, and so on. You can track responses during various stages of the campaign. Adding this information correctly helps your company to identify successful campaigns and stages to aid in refining and running successful campaigns in the future.

Campaign responses can be added and viewed in the Infor CRM Web Client Client.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>You need to add a response for a recent campaign. The individual has decided to purchase from your company.</td>
</tr>
</tbody>
</table>

To add and view campaign responses

1. Open the IL Return Mail Ad Q4 FY2017 campaign in the Campaign Detail view.
2. Click the Responses tab.
3. Click the Add Campaign Response button.
4. Select Contact, click the Contact Find button, type st, click the Search button, select the first name in the list, and then click OK.
5. Click the Response Method drop-down arrow and select Phone.
6. In the Comments box, type Responded within 5 days. Qualifies for 10% discount and free carrying case.
7. In the Products section, click Add Product, click Search, select Kiva Big Mouth Briefcase, and then click OK.
8. Click OK.
Chapter 7
Working with Customer Service and Support

This chapter introduces you to the Infor CRM Customer Service and Support features. The Customer Service and Support features allow designated users to track, qualify, and resolve customer questions and issues.

In this chapter, you will learn how to:
- Understand and work with contracts
- Add, work in, and close tickets
- Add and close a return
- Add and close a defect

Working with Contracts

Contracts are agreements between accounts and your company to provide support for products sold. Infor CRM has five general types of contracts that cover support services. In addition, a contract can cover a specific set of products, or it can be a “blanket” contract that covers all products the account owns. You can use contracts to verify that support should be provided to specific accounts for specific products.

Understanding Contract Types

The five default contract types are:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days</td>
<td>The contract is tracked according to a number of days of services the account has purchased. This value is entered into the Quantity box for the contract. When the contract type is Days, and as activities are generated for the account, the value in the Remaining box will not decrement.</td>
</tr>
<tr>
<td>Hours</td>
<td>The contract is tracked according to a number of hours of services the account has purchased. This value is entered in the Quantity box for the contract. The total time is calculated using the Elapsed Hours value for all activities generated for the account. As activities are generated, the value in the Remaining box decreases to reflect the number of hours left on the contract.</td>
</tr>
<tr>
<td>Incidents</td>
<td>The contract is tracked according to the number of service calls the account has purchased. This value is entered into the Quantity box for the contract. The total number of incidents reflects the total number of tickets the account has opened. As tickets are opened, the value in the Remaining box decreases to reflect the number of incidents left on the contract.</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>The contract is tracked according to a currency value placed on the services the account has purchased. This value is entered into the List Price or Contract Amount box for the contract. When a ticket activity is created against the contract, the activity's Total value is charged against the contract amount, and the value in the Remaining box decreases to reflect the value left on the contract.</td>
</tr>
<tr>
<td>Perpetual</td>
<td>The contract has no limit. The account can open an unlimited number of tickets and activities for an unlimited amount of time.</td>
</tr>
</tbody>
</table>

To ensure that the time, number of incidents, or currency value left on a contract is tracked accurately, you must activate the contract before beginning work on a ticket.

**Adding a Contract**

Each contract you add must be connected with an account that already exists in Infor CRM. The following scenario explains how to create a contract for an account.

**Our scenario:**

Tom Dale calls to request a new contract. He wants a one year contract that covers up to 10 incidents.

To add a contract

1. Open the **Beeker Motors** Account Detail view and select the **Contracts** tab. If the tab is not visible, click the **More Tabs** tab.
2. Click the **Create Contract** button.
3. Complete the contract information boxes.
   a. In the **Reference #,** type a reference number for the contract.
   b. Verify that **Dale, Tom** is listed in the **Contact** box. If not, click the **Find** button and select **Tom Dale** from the lookup.
   c. Select **Active**.
   d. In the **Comments** box, type **New 1 year contract for 10 incidents. Qualifies for new customer discount.**
   e. Click the **Service** drop-down arrow and select **Classic Care Ultra** from the list.
   f. Click the **Contract Type** drop-down arrow and select **Incidents** from the list.
   g. Leave the **Start Date** as today's date.
   h. Click the **Expiration Calendar** button and select the date one year from today.
   i. In the **Quantity** box, type **10.** This specifies that the contract covers 10 incidents in the next year.
   j. Type a purchase order number in the **PO Number** box.
   k. In the **Purchase Date** box, select today's date.
   l. In the **List Price,** type **500.00.**
   m. In the **Discount** box, type **50.00** because he qualifies for a new customer discount. The Contract Amount is automatically calculated.
4. Click **Save**.
5. Associate Beeker Motors assets to the contract.
   a. On the Contract detail view, click the **Covered Assets** tab. If the tab is not visible, click the **More Tabs** tab.
   b. Click the **Associate Asset** button.
   c. In the lookup select **NetPrinter Laser Elite,** and then click **Add Selected.**
Working with Tickets

Tickets are records of customer inquiries or complaints. They can contain the information necessary to report, investigate, and close an inquiry or problem. Before you add a ticket, the account and contact must exist in Infor CRM.

Adding a Ticket

Our scenario:
Tom Dale at Beeker Motors called. He is having a problem with one of their printers and needs the problem resolved by the end of the week. You need to create a ticket to work on the problem.

To add a ticket
1. Open Tom Dale's Contact Detail view.
2. On the New menu, click Ticket.
3. In the Insert Ticket view, verify Beeker Motors appears in the Account Name box.
4. If necessary, in the Contact Name box, click the Find button, and then select Tom Dale.
5. In the Contract box, click the Find button, use the Lookup Contract to select the contract you created in the previous scenario, and then click OK.
6. In the Area box, click the Find button and in the Area list select Hardware. Options available for Hardware appear in the Category list.
7. In the Category list, select Printer.
8. In the Issue list, select Power, and then click OK.
9. In the Source box, click the drop-down arrow, and then select Phone.
10. In the Status box, click the drop-down arrow, and then select In Process.
11. Click the Urgency drop-down arrow, and then select Med-High.
12. In the Needed Date box, use the Calendar button to select a date at the end of the week.
13. Verify the Assigned To box lists your name. If necessary, click the Find button and select your name from the list.
14. In the Subject box, type a short summary of the problem.
15. In the Description box, click the Add problem timestamp button, and then type detailed information for the problem.
16. Under Comments, in the Internal box, click the User Date Stamp button, and then type additional information that is important to the ticket.
17. Click Save.

Adding Ticket Activities

Ticket Activities are added through the Ticket Activities tab on the Ticket Detail view. Ticket Activities enable you to track the time, the types of tasks, and any associated costs involved in resolving a ticket. Activities are recorded by activity type and charge rate and are used for billing the customer against their service contracts. You can add your own ticket activities at any time from the Ticket Activities tab.
Our scenario:
You told Tom Dale that you will research his problem and call him back. You need to add a ticket activity for the research time.

To add a ticket activity
1. Open Tom Dale's ticket.
2. Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab.
3. On the Ticket Activities tab, click Advanced.
   The Insert Ticket Activity view opens.
4. In the Type box, click the drop-down arrow, and then select Research.
5. In the Public Access box, click the drop-down arrow and select 1-Customer.
   This setting determines whether customers will be able to see the ticket activity using Infor CRM Customer Portal.
6. Verify that the User box displays your name. If not, click the Find button to locate your name or the name of the individual who will be responsible for completing the activity.
7. Verify that the Start Date box displays the correct start date and time for the activity. If not, click the Calendar button to specify the correct date and time.
8. Since you have not yet completed the activity, skip the End Date box. When you complete the activity, you will use the Calendar button to select the date and time you finished working on the activity.
   It is very important that you select accurate dates and times in both the Start Date and End Date boxes because this information is used to calculate the Time Units, Elapsed Hours, Rate, and Total Labor.
9. (If necessary) In the Charge Type box, click the Find button, select No charge, and then click OK.
   The charge type is the rate your company charges against the customer's support contract for the work you performed.
10. In the Comments box, type Research printer power issues.
11. Click Save.

For more information see the "Adding and Editing Ticket Activities" topic in the Infor CRM Web Client Help.
Punching In and Out of a Ticket

The Punch In and Punch Out function enables you to track the time spent assisting a customer for each ticket. When you click the Punch In button on a ticket's detail view, Infor CRM begins timing the activity. When you are finished, you can click Punch Out. Infor CRM stops timing the activity and adds an activity record to the Ticket Activities tab for the ticket.

When you use the Punch In/Punch Out feature in a ticket, a timed activity is automatically created.

Our scenario:
Tom Dale calls with more information on his printer problem. You need to open the ticket and track the time you spend talking to him and gathering information.

To punch in to and out of a ticket
1. From the Beeker Motors Account Detail view, click the Tickets tab, and click the ticket’s Ticket ID number.
2. Click the Punch In button. The button text changes to Punch Out, and Infor CRM begins recording time against the ticket activity.
3. Click the Ticket Activities tab. If the tab is not visible, click the More Tabs tab
4. From the list of ticket activities, click Edit next to the Timed activity you want to change.
5. Enter the information from your conversation with Tom Dale in the Comments.
6. Click Save.
7. When you are finished working on the ticket, click Punch Out to stop tracking time on the ticket.

Closing a Ticket

The stage at which a ticket is closed and the person responsible for closing a ticket depend on your company’s processes.

Our scenario:
You resolved the problem with Tom Dale’s printer and completed all follow-up activities. Now you want to close the ticket.

To close a ticket
1. Open Tom Dale’s ticket.
2. Ensure all ticket information is complete and accurate.
3. Close any open ticket activities.
   a. Click the Ticket Activities tab.
   b. Click Edit next to the Research activity.
   c. Click the End Date Calendar button, select a date, and then click OK.
   d. Click Save.
4. In the Status box, click the drop-down arrow, and then select Closed.
5. Click the Details tab and update the Resolution.
   a. Click the Date/Timestamp button.
   b. Type Printer overheats and turns off due to faulty fan.
6. If you want to submit the resolution information to be accepted into the SpeedSearch indexes, select the Submit for SpeedSearch check box in the top pane.
7. Click Save.

Working with Returns

Returns are agreements to accept returned products from a customer for service, replacement, refund, or credit. This may also be referred to as an RMA or Return Materials Authorization.

Adding a Return

Every return must be associated to a ticket. Before you add a return, ensure that the related ticket exists. If necessary, create the ticket before proceeding.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tom Dale reported a problem with a printer and sent it in for repairs. After researching the ticket, you determined that the printer must be replaced.</td>
</tr>
</tbody>
</table>

To add a return

1. Open Tom Dale's ticket.
2. Click the Returns tab. If the tab is not visible, click the More Tabs tab.
3. Click the Insert New Return button.
4. Verify that the Ticket ID, Account, and Contact are correct.
5. In the Reason box, type Printer overheats.
6. In the Customer PO box, type the customer purchase order.
7. Click the Status drop-down arrow and select Return Received.
8. Click the Type drop-down arrow and select Send Replacement.
9. Click the Priority drop-down arrow and select Next Day.
10. In the Expected By box, click the Calendar button, and select this Friday.
11. Click Save.
   The Return Detail view opens.
12. Click the Ship To Details tab. If the tab is not visible, click the More Tabs tab.
13. Verify the contact and address information is for Tom Dale at Beeker Motors.
Adding Products and Shipping Details to a Return

You add products to a Return to indicate which product the account is returning, and which is the replacement product to be shipped to the customer.

**Our scenario:**
You added the return for Tom Dale's ticket and now want to add the product asset that Tom is returning.

To add an asset to a return
1. Open the detail view for the return you created for Tom Dale's printer.
2. Click the Details tab. If the tab is not visible, click the More Tabs tab.
3. In the Assets to Return section, click the Associate Asset button.
4. Locate and select the NetPrinter Laser Elite printer using the lookup.
5. Click OK.

To update the shipping contact information
1. Click the Ship To Details tab. If the tab is not visible, click the More Tabs tab.
2. Verify that Tom Dale is the Contact.
3. Use the Ship Via and Tracking # boxes to include additional shipping information.
4. In the Attention box, type Tom Dale.
5. Verify that the address information is correct.
6. Type any special shipping instruction in the Special Instructions box.
7. Click Save.

To add the products to be returned and replaced
2. In the Add Return Shipped Product dialog box, under Received Product, click the Find button, select NetPrinter Laser Elite printer, and then click OK.
3. Select Return Existing.
   The returned product is automatically added.
4. Click the Shipped Date Calendar button and select today's date.
5. Click OK.

For more information see the "Using the Return Ship To Details Tab" topic in the Infor CRM Web Client Help.
Closing a Return

The stage at which a return is closed and the person responsible for closing the return depend on the process within your company. As an example, when the product has been returned by the customer and the replacement product has been shipped, that might be the stage at which you would close a return.

Our scenario:
Now that Tom Dale’s replacement printer has been shipped to him, you want to close the return.

To close a return
1. Open the detail view for the return you created for Tom Dale’s printer.
2. In the Status box, click the drop-down arrow, and then select Closed from the list.
3. Click Save.

Working with Defects

A defect is a record describing a problem in a product or process. It is similar to a ticket, but people involved in the design or construction of the product typically resolve defects. The system tracks defects so that problems with a product or process can be resolved in a timely manner, and company management is aware of issues with these products or processes.

Adding a Defect to an Existing Ticket

When you discover a problem in a product or process, you can add a defect to Infor CRM.

Our scenario:
After receiving Tom Dale’s printer you discovered that there is a defect with the cooling fan. You need to enter a defect to track the problem.

To add a defect to an existing ticket
1. Open Tom Dale’s ticket.
2. Click the Defects tab. If the tab is not visible, click the More Tabs tab.
3. Click the Create Defect button.
4. Click the Project drop-down arrow and select Hardware.
5. In the Version Found box, click the drop-down arrow, and select 1.
6. In the Target Version, click the drop-down arrow, and select 2.
7. In the Current Progress box, click the drop-down arrow, and select Customer Return.
8. In the Area box, click the Find button and in the Area list select Hardware.
9. In the Category list, select Printer.
10. In the Issue list, select Power, and then click OK.
11. Leave the Status as Open.
12. In the Source box, click the drop-down arrow, and select Parts.
13. In the Type box, click the drop-down arrow, and select Power.
14. In the Priority and Severity boxes, click the drop-down arrow, select the importance and impact of the issue.
15. In the Frequency box, click the drop-down arrow, and select Weekly.
16. Select the Submit for SpeedSearch option so that this issue can be found using SpeedSearch.
17. In the Public Access box, select 5-internal.
18. Click the Assigned To Find button, select your name from the list, and then click OK.
19. In the Subject type Printer fan stops and printer overheats.
20. In the Description box, click the User Date Stamp button, and then type Cooling fan stops which causes the printer to overheat and turn off during a print job.
21. Click Save.

Closing a Defect

The stage at which a defect is closed and the person responsible for closing the defect depend on the process within your company.

<table>
<thead>
<tr>
<th>Our scenario:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The problem with the NetPrinter Laser Elite fan has been identified. You are ready to add a resolution and close the defect.</td>
</tr>
</tbody>
</table>

To close

1. Open the defect you created for the NetPrinter Laser Elite.
2. In the Fixed in Version box, click the drop-down arrow and select an item from the list.
3. In the Status box, click the drop-down arrow, and then select Closed.
4. Click the Details tab.
5. In the Resolution box, click the User Date Stamp button, and then type Fan is too small. Any printers experiencing this problem should be returned and the fan will be replaced.
6. Click Save.
Chapter 8
Using Web Reporting and Analysis Tools

Infor CRM includes reporting and analysis tools that help you identify opportunities and evaluate sales effectiveness.

The Reports List view provides a list of pre-defined sample reports to enable you to view and analyze information in the Infor CRM database. You can run reports related to Main views such as Contact, Account, Opportunity and so on. If you prefer, you can modify the report to accommodate your business needs. The specific reports available to you are determined by your system administrator.

The Dashboard is a tool set that allows you to display and interact with a variety of performance and analysis information in a dashboard format. You can use the data provided to gain insight into organizational and individual performance, discover root causes for performance issues, and then take the corrective actions or make strategic decisions.

In this chapter, you will learn to:

- Use the Reports view
- Run a report
- Export and print reports
- Work with Dashboards
- Use Dashboard widgets

Using the Reports View

Reports enable you to view information about contacts, accounts, opportunities, tickets, and other related data.

The Reports view allows you to select from a list of available sample reports and apply filters to narrow the results. You can only access reports that have been released to you by the system administrator. Reports can be released to you personally, or to a team that you are a member of. When you view or print any report, only records you have access to are included in the report.

Our scenario:

You want to run a report listing all the interactions you have had with your contacts.

To run a report

1. On the Navigation Bar, click Reports.
2. In the Report list view, Reports tab, select the Contact Summary - Sample report, right-click, and then click Run.
   This is the option for reports you want to run only once, or reports you require immediately.
3. In the Select Records dialog box, in the Show records that match box, pick All Records.
4. Click Next.
5. In the Enter Values dialog box do the following:
   - Leave View Notes as Yes.
   - Use the pick list to change Start each contact on a new page to No.

6. Click Next.

7. In the Export Options dialog box, use the pick list to select PDF as the file format for your report.

8. If you selected Schedule in step 1, you can create a job schedule for running your report. Select from the available scheduling options.

9. Click Finish.

10. When the progress message box appears, do one of the following:
    - Wait for the job to complete and open your report from the link that displays.
    - Click Close to dismiss the box. The report continues to process in the background. When the report is available, a job notification alert appears in the menu bar. You can either view the report from the Job Notifications box or from the Reports History tab.

### Viewing, Printing, and Storing Reports

When you run a report, it is stored in the Reports History tab until you choose to delete it. From this tab you can see history for the report, open the report, print, save the report elsewhere, or store the report for future reference.

#### To find the Report History tab

1. On the Navigation bar, click Reports.
2. In the Report List view, click the History tab.

#### To open a report

- In the Report History tab, in the Report column, click the report name.
  The report opens in the native application for the report file type.

#### To print or save the report

- Use the tools available in the native application.

#### To delete a report

1. In the Report History tab grid, select the report.
2. Right-click and then click Delete.
Working with the Dashboard

The Dashboard allows you to display and interact with a variety of performance and analysis tools on the Welcome page of the Infor CRM Web Client. You can maintain one or more personalized dashboard tabs and, with the appropriate permissions, you can modify dashboards provided by Infor CRM or customized by your administrator.

You can format the data on the dashboard using widgets to gain insight into organizational and individual performance. The data can be visualized in a pie, bar or column chart, pipeline, or line graph, or you can view the detailed data in a list. A widget is a dynamic, reusable element of the interface that displays the data you specify. For more information about widgets, see See "Working with Widgets" on page 60.

There are two out-of-the-box dashboard tabs: My Dashboard and Sales. Each tab has several out-of-the-box widgets. You can add and edit widgets to display different data or display the same data in different ways.

To open the dashboard

- On the Navigation Bar, click Welcome.

Customizing Your Dashboard

Use the context menu on a dashboard tab to add a new tab, copy, hide/show and delete tabs, or share tabs with your team or department. Use drag-and-drop to rearrange the widgets on the tab. Widgets automatically size to fit the data and chart type, as well as the column size.

You can also send all the data for a group from a list view to a group list widget on the dashboard with the Promote to Dashboard link.

To add a new tab

1. Right-click any dashboard tab, and click New Tab.
2. In the Title box type a name for the tab.
3. If necessary, select the template that describes the type of layout you want to use for your tab.
4. Click OK.

To share a tab with other users

1. Right-click the dashboard tab, and click Share Tab.
2. Do one of the following:
   - Click Everyone to share the tab with all users.
   - Click the Add button, find the users, teams or departments you want to share the tab with, and then click OK.

To promote a group to a dashboard

1. From a list view, click the group tab you want to send to the dashboard.
2. In the Task Pane, click Promote to Dashboard.
3. Click the name of the dashboard where you want to send the data, and click OK.
4. Click OK.
5. Click Welcome in the Navigation Bar and select the dashboard tab you selected in step 3.

The data appears on the dashboard in a group list widget. The default configuration for the group list is 10 lines; however you can change this in the widget editor to display up to 50 lines.
Working with Widgets

Widgets are plug-ins you can add to a dashboard. There are several types of widgets you can use to display your data. Move your mouse over the chart in a widget to display the dimension and metric selected for that widget.

There are several types of widgets:

- The list of available widgets is determined by your implementation. You may not have access to all widget types.
  - Charting - Bar, Column, Funnel, Line, and Pie charts
  - List - Group, Links, and Recently Viewed
  - Other - Today's Activities and Welcome

Using Widgets

You can add, edit, and remove widgets from the dashboard, and you can rearrange widgets on the page with drag-and-drop.

Our scenario:

You want to show potential revenue of opportunities in your pipeline for each level of revenue.

To add a funnel chart widget

1. Right-click a Dashboard tab and click Add Content.
2. Click the Add button under Funnel Chart.
3. Type a Title for the funnel chart, for example Open Opportunities by Sales Potential.
4. In the Entity list select Opportunity.
5. In the Group list select All Open.
6. In the Dimension list select Stage.
7. In the Metric list select Sum Sales Potential.
8. Determine if you want to Display Labels, Truncate Labels and what the Label Length is.
9. Click OK.
   A range of sales potential amounts displays with each sales potential range represented as a different colored level. The size of each level represents the number of opportunities within a particular sales potential range.

To add content to a widget

1. Right-click the My Dashboard tab, and click Add Content.
2. On the Add Content dialog box, click the Add button for the widget you want to add.
3. Configure the widget settings, and click OK.

To edit a widget

1. On the widget toolbar, click the Settings button.
2. Make the changes necessary.
3. Click OK.
   The widget displays the changes.
To minimize a widget

- On the widget toolbar, click the Minimize button.
  The widget content is minimized in the dashboard. Click the button again to maximize the widget.

To remove a widget

- On the widget toolbar, click the Close button.
  The widget is permanently removed from the dashboard.
Infor CRM provides tools to allow you to modify some parts of the interface so that you can work in the way that suits you best. User Options allow you to set specific preferences for such features as the view that appears when you start the Infor CRM Web Client and Alerts. Your settings that you enter are recorded for you and are not visible to other Infor CRM users. Some options are shared between the Infor CRM Client and Infor CRM Web Client.

General Options

Use the General tab to specify such settings as which view opens by default when you first log into Infor CRM Web Client, and who to use as the default owner for any new records you create. You can also set options for using Mail Merge, although these will not be visible unless you installed Desktop Integration. See "Understanding Infor CRM Office Integration" on page 12.

To set general options

1. On the Tools menu, click Options.
2. Click the General tab.
3. In the Show on Startup box, select the default view you want to display when you log in to the Web Client, (for example, What's New or Calendar).
4. In the Default Owner/Team box, click the Find button, select the user or team you want to be the default owner for new accounts, and then click OK.
5. If you want to be automatically logged out of the Infor CRM Web Client after a period of inactivity, select the Enable Automatic Logoff option, and then type the allowable number of minutes of inactivity.
6. If you want to be notified when you have unsaved changes on a page, select the Prompt for unsaved data check box. This option is selected by default. Clear the check box if you do not want to be notified.
7. Select the Default Username/Time Stamp in Memo Fields if you want to have the option to click the User Date Stamp button to add your name, the date, and time (according to your language settings) to a memo box.
   This option will only work on memo boxes on which your administrator has turned on this feature.
8. If you need updated pick list data, click the Refresh Pick List Data button.
   You should only click this button if there are updated pick list items available. For example, the Opportunity Status pick list has been updated.
9. For Multi-Currency only: To select a currency type, click the My Currency Find button, select a currency from the list, and then click OK.
10. In the Contact Sync Group, select an ad hoc contact group that will contain the contacts to synchronize. If the ad hoc group you want to sync your contacts to does not appear in the list, you must create the group.
    Do not select a contact sync group if you are only synchronizing with Outlook using Outlook sync. If you are using Outlook sync, see "Configuring the Contact Sync Group" in the Infor CRM Web Client Help.
11. Select the Display List view check boxes option if you want all of your list views to include a column of check boxes.
12. Select the Mail Merge Base Templates you want to use when creating a new contact e-mail, fax, or letter template.
   a. Click the Type drop-down arrow and select Contact.
   b. Click the E-mail Base Template Find button.
   c. Select a template and click OK.
   d. Repeat steps b-c for Letter Base Template and Fax Base Template.
13. Select the Mail Merge Base Templates you want to use when creating a new lead e-mail, fax, or letter template.
   a. Click the Type drop-down arrow and select Lead.
   b. Click the E-mail Base Template Find button.
   c. Select a template and click OK.
   d. Repeat steps b-c for Letter Base Template and Fax Base Template.
14. In the Write Menu - Recent Templates box, enter the number of templates you want to display in the most recently used templates list.
15. In the Fax Provider box, click the drop-down arrow and select the fax provider you want to use for faxing.
16. In the Log to History box, select Prompt if you want the Complete E-mail dialog box to display after you drag and drop an e-mail message. If you want the message to be recorded to history without prompting, select Do Not Prompt.
   This option only applies to dragging and dropping e-mails. You must set options for Send to CRM and Record to History in Outlook. See "Configuring Outlook Integration" on page 14.
17. To install Office Integration, click Install Office Integration.
18. To install Infor CRM Xbar for Microsoft Outlook, click Install Xbar for Outlook.
19. For Offline Web Client users only: To run reports while see target, ensure the Use ActiveReporting check box is selected.
20. Click Save. You must click Save on each tab or your option selections will not be saved.
Group Options

Use the Groups options tab to determine how your groups, list views and lookups will appear and behave. These options only apply when the current user is signed in to the Infor CRM Web Client.

To set group options

1. On the Tools menu, click Options.
2. Click the Group tab.
3. Set your Group Options.
   a. Click the Main View drop-down arrow and select a view from the list.
   b. Click the Default Group drop-down arrow and select a default group from the list. For example, Latest Contacts.
      - The default layout for new groups is determined by the group selected as the default group.
      - If your default group does not display as a tab, you must mark it as a Favorite in the Groups list.
   c. Click the Default Lookup Layout drop-down arrow and select the name of the group with the layout you want to see for any lookups on that main view. For example, on the Contact views, all lookups will use the Latest Contacts group layout. The group you select will also determine what search items are available in the Lookup. The Lookup by options depend on the columns included in the layout of the lookup. You should choose a group that includes all of the columns you may want to search by in a lookup.
   d. Repeat steps a-c for each main view.
4. Under General Lookup Options, click the Default Lookup Condition drop-down arrow and select the lookup condition you would like to use for all list view lookups. Options include: Starting With, Contains, Equal to, and Not Equal to.
5. Click Save.
   You must click Save on each tab or your option selections will not be saved.

Activities Options

Use the Activities tab to set defaults such as activity type.

To set activity options

1. On the Tools menu, click Options.
2. Click the Activities tab.
3. From the Default View drop-down list, select the tab name for the type of activities you want to display in the Activity Main view (for example, All Open).
4. In the Default Follow-up Activity drop-down list, select the type of activity to be scheduled as a follow-up, after you complete an activity.
5. In the Carry Over Notes drop-down list, select Yes if you want to carry over any existing notes. when you schedule a follow-up activity.
6. In the Carry Over Attachments drop-down list, select Yes if you want to carry over any existing attachments when you schedule a follow-up activity.
7. Select Display Past Due in the toolbar if you want to be notified of past due activities.
8. Do one of the following:
   - Select **Show history for all participants** if you want history records for all activity participants to display in the detail views Notes/History tab.
   - Clear **Show history for all participants** if you want history records for only the primary participant to display in the detail views Notes/History tab.

9. Under the **Defaults Per Activity Type** section, set the Default Alarm and Default Duration for each activity type:
   a. Click the **Default Alarm** drop-down arrow and select from the list to set the default alarm when scheduling a new meeting.
   b. Click the **Default Duration** drop-down arrow and select from the list to set the default duration when scheduling a new meeting.
   c. Select the **Default Timeless** option if you want an activity to be timeless by default.
   d. If you selected the **Default Timeless** option and you want activities to automatically rollover to the next day if they are not completed on the scheduled date, then select the **Auto Rollover** option.

   ![You can only rollover timeless activities.](image)

   e. Repeat steps a-d for Phone Call, To Do, and Personal Activity.

10. Click **Save**.
    You must click **Save** on each tab or your option selections will not be saved.

### Calendar Options

Calendar Options allow you to adjust the content and appearance of your calendar to accommodate the way you work. You can set the type of information that displays in activities, the start and end of the work day, the default calendar view, default interval on the calendar, and whether or not completed activities (history) items display. History items only display on the day and week calendars by default.

**To set calendar options**

1. On the **Tools** menu, click **Options**.
2. Click the **Calendar** tab.
3. In the **Default Calendar View** box, click the drop-down arrow and select the default calendar view you want to display when you open the Calendar view.
4. In the **Num of Events on Day/Week** box, click the drop-down arrow and select the maximum number of events that you want to display in the top part of the Calendar Day and Week views.
5. In the **Show History on Calendar** box, click the drop-down arrow and select **Yes** to display history items or **No** if you do not want history items to display on the Calendar Day view.
6. In the **Remember Selected Users**, click the drop-down arrow and select **Yes** if you display multiple users on your calendar view and want to save the list of users between sessions.
7. Set the **Show on Activities** options to define how activities are displayed on the Calendar timeline for day and week views. These options do not apply to the month view.
   - **Opportunity** - Displays an activity's opportunity information, if applicable, on the day and week calendar views.
   - **Phone Number** - Displays an activity's phone number information on the day and week calendar views.
   - **Regarding** - Displays an activity's regarding information on the day and week calendar views.
   - **Time** - Displays the activity's start and end times on the day and week calendar views.
8. Under Work Week, select the days of the week that are included in your work week.
9. In the First Day of the Week box, click the drop-down arrow and select the day on which your work week starts.
10. Set the following options to customize your calendar:
   a. Contact/Account - Select how you want contact and account information to display on the Calendar. This option does not apply to the month view.
   b. Day Start - Select the time that your workday begins.
   c. Day End - Select the time that your workday ends.
   d. Default Interval - Select whether the calendar displays information in 15, 30 or 60 minute intervals.
   e. Default Activity Type - Select a default activity type. This is the type of activity that will be created when you double-click on any of the Calendar views.
11. Click Save.
    You must click Save on each tab or your option selections will not be saved.

Alerts Options

Use the Alerts tab to set defaults to determine how you will be alerted for alarms and new unconfirmed activities.

To set alerts options
1. On the Tools menu, click Options.
2. Click the Alerts tab.
3. Select Display in toolbar if you want Alerts to appear in your toolbar
   - If you do not select this option, then the remaining check boxes will be unavailable and you will not be notified of your Alerts.
4. Select Prompt if you want the Alerts dialog box to display when you have new alerts.
5. Next to Include, select the information you want to include in your Alerts. If you selected Prompt, this is the information that will cause the Alerts dialog box to open:
   - If you do not select any options, and you selected to display or prompt for Alarms, then your Alerts will be empty and will not prompt.
   - Select Alarms if you want your alarms to display in your Alerts.
   - Select Unconfirmed Activities if you want your unconfirmed activities to display in your Alerts.
6. Click the Default Snooze drop-down arrow and select from the list to set the default amount of time to postpone an activity alarm. You can still change the snooze time from the Snooze list before you snooze your alarms.
7. Click Save.
   You must click Save on each tab or your option selections will not be saved.

Opportunity Options

Use the Opportunities tab to specify default settings for any new opportunities that you enter into the Infor CRM Web Client. These options only apply when the current user is signed in to the Infor CRM Web Client.

To set opportunity options
1. On the Tools menu, click Options.
2. Click the Opportunities tab.
3. In the Opportunity Description area, select Use default name conventions if the default names will be controlled by a script. A sample Opportunity Description will appear in the space below the check box. Contact your administrator if you are unsure whether or not you should select this item.

4. In the Opportunity Status box, click the drop-down arrow and select from the list. (The default setting is Open.)

5. In the Opportunity Type box, click the drop-down arrow and select from the list. (This setting is blank by default.)

6. From the Probability drop-down list, click the drop-down arrow and select a probability of close that will be the default for new opportunities. This option is ignored if you choose a Sales Process in step 9.

7. To set the estimated close date for the new opportunities you create, select the number of months in the Set estimated close date to x months after opening drop-down list. You can select from 0 to 36.

8. If you want opportunities to close at the end of the month selected in the preceding step, select the Initially change estimated close to last day of month check box.

9. Select a process from the Sales Process list. The list consists of all released sales processes. The default setting is blank.

   The Default Sales Process box will be unavailable if the SalesLogix Advanced bundle is not installed.

10. In the Default Contact(s) area you can determine which contacts should be added to new opportunities by default. Default Contact options are:

    - Add all contacts associated with account
    - Add only the account's primary contact
    - Add no contacts

11. For Multi-Currency only: Click the Default Currency Find button to select from the list.

12. To include products for all new opportunities by default, click the Products button, to open the Add Product dialog box.

   This option is not available if Accounting Integration is configured.

13. Click Save.

   You must click Save on each tab or your option selections will not be saved.

**Changing Your Password**

You can change your password through the Options in the Infor CRM Web Client.

To change your password

1. On the Tools menu, click Options.

2. Click the Password tab. Type your password in the Current Password box.

3. In the New Password box, type your new password.

4. Retype your new password in the Confirm Password box.

5. Click Save.
User Profile Options

Use the User Profile options tab to determine how the Infor CRM Web Client will appear and behave. These options only apply when the current user is signed in to the Infor CRM Web Client.

If Infor Mingle single sign-on is configured, Infor CRM language settings will be based upon the browser language settings, not the User Profile, Language Selection. Infor CRM recommends making sure that both the browser and Language Selection are the same to ensure an optimal experience.

To set user profile options
1. On the Tools menu, click Options.
2. Click the User Profile tab.
3. If necessary, change the language setting. Changing the language will cause the Infor CRM Web Client to display in your selected language. If you do not select a language, then the Infor CRM Web Client will use the default language. The list of languages is based upon the languages supported by your organization.
   - Click the Language Selection drop-down arrow and select a language from the list.
4. Click Save. You must click Save on each tab or your option selections will not be saved.

Setting Customer Service Options

Customer Service Options allow you to set options like date and time stamp settings and time tracking options.

To set customer service options
1. On the Tools menu, click Options.
2. Click the Customer Service tab.
3. Under Time Tracking, do the following:
   a. If you are required to track your time when processing new issue, select Automatically Punch In to a new Ticket.
   b. If you are required to track your time when processing and resolving existing issues, type the number of minutes in the Prompt to Punch In to an existing Ticket text box.
   c. Select Display Ticket Activity on Punch Out to automatically display the Edit Ticket Activity dialog box for you to enter activity information when punching out of a ticket.
   d. Select Display Ticket Activity on completion of Calendar Activity (Windows version only) to automatically display the Edit Ticket Activity dialog box for you to enter the activity information for a completed calendar activity.

   This option only applies to the Windows Client.
4. Click Save.
Index

A
Account
  add asset 37
  adding 18
  associating 19
  contracts tab 48
  defined 17
  manager 17
  owner 17
  viewing history 30
Account Manager 17
Account owner 17
Account ownership 17
Activities
  add members 28
  adding to tickets 49
  completing 27
  completing unscheduled activities 27
  defined 21
  invite others 28
  options 65
  scheduling 21, 29
  tab 22
  unscheduled 27
  view 22, 29
Activities view 29
Activity and Alarm
  options 65
Adding
  Account assets 37
  Account association 19
  activities to tickets 50
  activity members 28
  campaigns 43
  contact and Account 18
  dashboard tabs 59
  defects 54
  leads 39
  notes 22
  opportunities 35
  returns 52
  ticket activities 49
  tickets 49
  widgets 60
Alarms
  dismiss 26
Area/Category/Issue 49, 54
Assets
  add to account 37
  Associating
    accounts 19
C
Calendar 28
  day view 29
  month view 29
  week view 29
Campaigns 43
  adding 43
  adding products 45
  adding stages 44
  adding targets 43
  adding tasks 44
  defined 43
  launching 45
  overview 43
  tracking responses 46
Closing
  defects 55
  opportunities 37
  returns 54
  tickets 51
Completing
  activities 27
Contacts
  
  adding 18
  defined 17
  look for matching records 18
  sending literature 20

Contracts
  
  blanket 47
  days 47
  defined 47
  hours 47
  incidents 47
  overview 47
  perpetual 48
  value 48

Customer Relationship Management 17
Customer Service 47

D

Dashboards 59
Date Stamp 49, 51, 55

Defects
  
  adding to a ticket 54
  assigning 55
  closing 55
  defined 54

Detail view 9
  
  tabs 9
  user-defined area 9

Dismissing alarms 26

Duplicates
  
  look for matching records 18

E

Editing
  
  widgets 60

Email 33
  
  sending with mail merge 32
  sending with Outlook Integration 34

F

Follow-up Activity 28

G

Groups 1, 8

H

Help 11
History of account 30

I

Import
  
  leads from a list 40
Installing
  
  Xbar for Outlook 14

L

Language selection 5
  
  user profile option 69

Launching
  
  campaigns 45

lead
  
  convert 42

Leads 40
  
  adding 39
  defined 39
  importing from a list 40
  qualifying 42

Library 20
  
  accessing 20
  overview 20

List view 8

Literature Requests 20
  
  scheduling requests 20

Lookups 1, 34, 42
  
  example 19
Index

M
Mail Merge
creating templates 32
overview 1, 32
private templates 31
public templates 31
send e-mail using 32
templates 31
Manage Templates 31
Meetings
inviting members 28
scheduling 28
Menu Bar 7
Metric 60
Microsoft Outlook 33
  send an e-mail 34
Microsoft Word templates 31
O
Opportunities
adding 35
adding contacts to 35
adding products to 35
closing 37
overview 35
statistics 36
Options
activities and alarms 65
user profile 69
Outlook Integration 33
Owning accounts 17
P
Password 5
Phone calls
  scheduling 21, 29
Pick List 7
Private templates 31
Products
  adding to a campaign 45
Promote 59
Public templates 31
Punch In/Out of a Ticket 51
Q
Qualifying
  leads 42

R
Related Documentation 2
Removing
  widgets 60-61
Reporting
  using 57
Reports
  overview 57
  running 57
Reports view 57
Resolution
  closing a defect 55
  closing a ticket 51
Responses for campaigns 46
Returns
  adding to a ticket 52
  associating assets 53
closing 54
defined 52
shipped product 53
shipping details 53

Getting Started with the Infor CRM Web Client
S
Scheduling follow-up activities 21, 29
Scheduling meetings 28
Selecting a language 5
Send to CRM 33
Sharing
  dashboards 59
Signing in 5
SpeedSearch 52
Stages 44
Statistics
  opportunity 36
Status
  closing a defect 55
  closing a return 54
  closing a ticket 51
  closing an opportunity 37
Status Bar 7
T
Tabs 7
  detail view 9
Targets
  adding to a campaign 43
Tasks 44
Templates
  creating 32
  overview 31
  private 31
  public 31
Ticket Activities
  charge type 50
  defined 49
  end date 50
  timed using Punch In/Out 51
Ticket Activities tab 49
Tickets 49
  adding 49
  adding a return 52
  Area-Category-Issue 49
  closing 51
  defects tab 54
  description 49
  insert new activity 50
  public access 50
  punching in or out 51
  resolution 51
  submit for SpeedAearch 52
  ticket activities tab 49
  tracking time 51
Time Stamp 49, 51, 55
Title Bar 7
Tracking
  campaign responses 46
  time for tickets 51
U
Unscheduled activities 27
V
Viewing
  scheduled activities and events 28
W
Welcome
  dashboards 59
Workspace 6
  buttons 10
X
Xbar
  features 13
  installing 14